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Using Cachet Introduction Welcome to Cachet!

Cachet provides a simple way to achieve consistent,
high-quality color reproduction of photographs from
your Macintosh.

Cachet is a color editor. With it, you can correct color problems that result from
improper combinations of lighting, exposure, and film in the photographic
process—for example, using daylight film under fluorescent light.

You can also change individual colors in an image or enbhance the overall color

message.

Most important, you can control printed results without expert knowledge of

the color reproduction process.

In short, you can do the work that is normally done by a skilled graphic arts
technician with a complex color separation scanner. But you can do it on your

Macintosh using simple color editing tool.



Using Cachet Introduction Cachet—

Five steps to predictable,

professional color results

When you work with Cachet,
you work visually. You don’t

need to understand color theory or color math.

Instead, you rely on your own direct perception of color,
following five basic steps:

Step 1: Display the images you want to work with on the
screen.

Step 2: Correct the overall color, if necessary.

Step 3: Adjust selected colors, if you want.

Step 4: Save your changes.

Step 5: Tell Cachet how you want to print.

Cachet automatically adjusts the image—with your color

corrections—to achieve the best printed results using the
printer or other reproduction method you choose.
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Introduction Step 1:

Display the images you

want to work with

When you work with Cachet,

you usually work with two

images—a working image and one or more reference images.

* The working image is the image you want to correct. You
can use a scanner to digitize the image so you can display it on
the screen.

* Reference images are your guide to color correction. They're
digital images that have already been corrected in Cachet and
printed with good results.

When you display a reference image on the same screen as
your working image, you don’t need to worry about calibrating
your monitor. With Cachet’s Edit by Reference feature, you
simply compare the colors in the working image with those in
the reference image. If they appear similar on the screen, they
will appear similar when printed with Cachet.

Cachet comes with a set of reference images in both digital and
printed form. Once you've used Cachet to print your own
images, you can use them as reference images, too. In fact,
every image you correct and print successfully with Cachet
becomes a reference image.

See Chapter 1 for details about displaying images, including
suggestions for choosing and using reference images.
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The Cachet Reference
Image Guide shows
you what the reference
images look like

when they're printed.

Step 1

Frisbee Team - (Reference)

When you work with
Cachet you edit by
reference—you adjust
the color of your
working image, while
comparing itto a
reference image.

If your image has

the same color char-
acteristics as the
reference image and
you know what the
reference image looks
like when it’s printed,
you can predict how
your image will look
when it’s printed.
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Introduction Step 2:

Get the overall color

right—exposure, tone,

With Cachet, you start your and color appearance

color corrections by changing

the color characteristics that
affect the entire image.

* First, you correct problems that arise from poor exposure of
the original, including color balance.

* Second, you adjust the tone of the image—white point,
black point, contrast, and brightness in the midtones,
highlights, and shadows.

* Third, you adjust the color appearance of the image by
adjusting the saturation, color cast, and overall lightness, if
necessary.

Chapter 2 describes the tools and methods for making these
overall corrections.

Of course, not every image needs all this work. Often you can
correct an image simply by adjusting the exposure, color
balance, white point, and black point. Sometimes you don’t
have to make any changes at all. You can just skip to step 5
and print.
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File Edit Imo: Tools Playback Windows
i

You use the
Exposure & Tone
palette first to
correct problems
with the original—
problems that
arise from
improper
exposure, film, or
lighting.

Then, you use the . Tools Playback Windows

Color palette to D ————— Ueggies -
enhance the color

appearance—

to improve

saturation, for
example.




Using Cachet Introduction Step 3:

Adjust selected areas of

color—to match memory

Sometimes you want to adjust JEUGET VAV (TS
specific colors. Maybe it’s a

flower that you want to change
from red to purple or a faded green lawn that you want to
make more lush. Maybe it’s a color emblem on a baseball jersey
that needs to match the team’s color exactly.

With Cachet, you can change selected colors in an image
without affecting others. You can manually adjust the
saturation, color cast, and lightness of selected colors. Or you
can let Cachet adjust them automatically to match colors in a
reference image or in another part of the working image. You

can even specify PANTONE® Colors.

Chapter 3 explains how to make these selective changes.
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You use the wand
to select colors
you want to
change.

" & File Edit Imoge Tools Playback Windows
Io1 —J0 !

Then, you use the
dropper to match
other colors
automatically.

Match another
color in the same
image orin a
reference image.
Or specify a
PANTONE Color.
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Introduction Step 4:

Save your work—in

snapshots, scripts, and

With Cachet, you can save files
your work in three ways:

* You can take quick snapshots as you work to save interim
versions of the image until you decide which ones you like
best.

* You can save a script that permanently records all the
changes you've made to an image. Then, you can use the script
to apply the same corrections to several similar images.

* When you've got an image the way you want it, you can save
the changes in a file, either replacing the original file or
creating a new one.

These three methods help you save time and disk space, and
provide the flexibility to experiment. See Chapter 4 for details.
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Snapshots are temporary— Toke Snopshot
they're great for keeping track of r
changes as you work with one Attt
palette or another. Cachet

Snapshot 4
discards them when you close

. . What is this Snapshot’s name?
the working image. o sk 2
D Script 2
D script 3
D Script 4
uddie Stomping
3 Sunny Plenic 'Sove
D Vegetable Basket
Save Document as: scfipw are pefmanent—yau can
[Puddie stomping ]
— e — use them to make the same

changes to similar photographs.

Files are the standard way to save
images for the next steps in the
process—page layout, proofing,
and color separation.
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Introduction Step 5:

Print your images—with

consistent, faithful color

When you're ready to print, reproduction
EfiColor, the patented color

technology behind Cachet,
guarantees faithful color reproduction. You can print directly
on a color printer. Or you can make color separations, import
them into a page layout program, and then print composed
pages on a printer or produce color separation films on an
imagesetter.

In both cases, Cachet automatically adjusts the colors in your
image for the best possible reproduction with the printer or
reproduction method you're using. You don't have to
understand the details of color reproduction.

But if you want more control of the reproduction process,
Cachet also provides tools that display information about the
color characteristics of your image as you make adjustments of
your own. You can use Cachet’s gamut alarm to identify colors
that your printing method cannot precisely reproduce. You can
use Cachet’s color meter to read the color values that Cachet
will use to reproduce your image on the printer you specify.

Chapter 5 explains how to use these tools to make color
checks, how to print directly to a printer, and how to make
color separations.
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3

Cachet uses a gamut alarm to
predict which colors will be out of
the gamut of your printer or printing
method.

Cachet adjusts these colors
automatically when you print.
Or you can adjust them yourself
before you print.

@ File Edit Imoge Tools Playbock Windows
[ic! =

Cachet also manages the
decisions that are necessary
to translate your corrected
color images faithfully into
color separations.
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Introduction Before you start—

What you need to know
and do

Before you start to use Cachet,

you should know the basics of
working with a Macintosh computer—how to start and quit
applications, how to use a mouse, and how to work with
menus, commands, and windows.

Then, you need to install Cachet and the reference images on
your hard disk. Cachet comes with an Installer that simplifies
installation. The Start Here guide tells you how to use it.

Once you've installed Cachet, take some time to practice.
Learning Cachet provides a tutorial guide to Cachet, as well as
an introduction to the workaday world of desktop color.

You can use this book, Using Cachet, as a how-to reference as
you work. The first five chapters explain the five basic steps in
correcting and printing a color image. The last chapter is a
description of the software and menu commands.
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Using Cachet Displaying the Images

In Cachet, you work with two kinds of images—working images that you want
to correct and reference images that you use as guides for making color
corrections.

Typically, your working image is from a slide or photograph that you scanned
and saved as a digital image. It may also come from a video frame you
captured from a video source.

Reference images are digital images that have been color-corrected with
Cachet and then printed, so they produce known results. Cachet comes with a
set of reference images—in digital and printed form. You can choose a reference
image from this set. As you work with Cachet, you will also accumulate your
own library of images you've printed with Cachet. You can use these images as
reference images, too. The more you work with Cachet, the larger your
collection of reference images will be.

10 begin color correction, you open your working image and one or more
reference images on the screen. If the working image has been scanned or
captured in the wrong orientation, you can flip or rotate it. You can also crop,
resize, or resample it before you begin to work. As you work, you can change the
view through the window—scrolling, zooming in or out, and changing the
amount of detail you see.

This chapter explains these basics.
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Displaying the Images The Working Image:

The image you want to

change—a photograph, a
The working image is the video frame, or artwork
image you want to adjust—to RGBT Rt /|
improve overall color quality,
to change individual colors, to

make a particular color statement, or just to make sure that it
prints well on the printer you're using.

If your working image is already in digital form (available as a
Macintosh file), you can open it in Cachet and begin color
correction immediately. Cachet can open files that have been
saved in any of the following formats: TIFF-RGB, PICT,
Adobe Photoshop, and Raw-RGB.

If your image is not in digital form, you must scan it. You can
scan a photograph directly as you work in Cachet if you have a
scanner and the appropriate plug-in module—a mini-
program supplied with the scanner. You can also use plug-in
modules to capture images directly from a video source or to
compress and de-compress image files. For more details, see
the sidebar on plug-in modules or refer to “Plug-in Modules”
in the section on “The Software” in Chapter 6.

You can open only one working image at a time.
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To open a file in TIFF-RGB,
PICT, or Photoshop format
as the working image

 Choose Open from the File menu.

e Click Correction to open the file
as a working image.

* Select the image you want to
change from the dialog box.

* Click Open.

Displaying the Images The Working Image

You can open any file in TIFF-RGB, PICT, Adobe Photoshop,
or Raw-RGB format as a working image. When you choose
Open, Cachet lists the available TIFF-RGB, PICT, and
Photoshop files in a dialog box:

Select o file to open:

> Hord Disk 2

g 0On @ Picnic ——J)
on the
D !:Iul: S:::nollg
D sunny Plcnic ——
ObepafatN Nooton -~ Make sure this
5| [ Cencel”] aves l d
Format: TIFF e option is selecte
le Size: 533,754
i 3/10/91, 11:24 M O Reference to open the file as a
Modified: 3/10/91, 11:24 AM [ see all files working image.

Cachet displays information about
the selected file here.

After you click Open, the working image appears in a window
with the file name in the title bar. The changes you make affect
only this image.

When you open an image file, Cachet generally doesn't display
all the image data unless the file is relatively small. Instead,
when you open the image, Cachet creates an internal model
of the image. The internal model is a subsampled (or lower-
resolution) version of the original working image. The data in
the internal model usually provides adequate resolution for
screen display. However, you can use more of the image data to
improve the resolution as you work. (See “To increase or
decrease the amount of detail” in the section on “The View
Through the Window” later in this chapter.)

TIFF-CMYK files If you have any files in TIFF-CMYK format,
these files also appear in the dialog box and Cachet shows their
file format as TIFE. However, you cannot open TIFF-CMYK
files in Cachet.
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To open a file in Raw-RGB  Raw-RGB format is a simple file format for storing images.

format as the working Since Raw-RGB format is the simplest—and most primitive—

image image file format, it can sometimes be used to exchange image
data between applications and devices that do not support

« Choose Open from the File menu. ~ more advanced file formats like TIFF-RGB.

* Click “See all files.” If you have saved a file in Raw-RGB format, or if you have a
file that was created in this format, you can open it in Cachet.

« Select an image from the listof ~ When you click “See all files” in the Open dialog box, Cachet

all files. displays all the files on your disk. When you select a file that is
not in TIFF-RGB, PICT, or Photoshop format, Cachert tries to

* Click OK. open it in Raw-RGB format. It asks you for additional
information that it needs to open the file:

You must
Raw File Reading Options provide the
Color Format lllidth: dimensions
Interleaved Height:[o and the header
Planar Header Size:[o size of the file.

If you don’t choose the correct format, Cachet opens
the file, but the image is not properly displayed.

If you don't provide the dimensions of the file or if the file is
not actually in Raw-RGB format, Cachet cannot open it.
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To open a compressed
image as the working
image

* Choose Import from the File
menu.

e Select a plug-in module from the
“Import using” pop-up menu.

e Click Correction to open the file
as a working image.

e Click Import.

 Select options in the dialog box
that appears.

e Click Open.

Displaying the Images The Working Image

You can compress and de-compress image files with any plug-
in module that’s compatible with Adobe Photoshop. Often,
image files are compressed to save space on your disk. (For
details, see the sidebar on “Plug-in Modules” or refer to “Plug-
in Modules” in the section on “The Software” in Chapter 6.)
When you want to work with a file that has been compressed,
you must first de-compress it.

When you choose Import from the File menu, Cachet displays
a dialog box so you can choose a plug-in module and a file to
de-compress.

Import using:[ Storm JPEG Decompress...

Import for...
Correction
O Reference (:ance Impoﬂ
/

Click Correction to open Choose the plug-in
the compressed image as  module you want from
the working image. this pop-up menu.

After you click Import, the plug-in module you selected
displays its own dialog box with any options or settings you
need to select. For information about these options, refer to
the documentation that came with the plug-in module.
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To scan a slide or You can scan an image from within Cachet if you have a

photograph or capture a scanner and a plug-in module for the scanner. You can also

frame from a video source capture an image from a video source, such as a VCR, using a
plug-in module designed for the video source. (For more

* Choose Import from the File information about plug-in modules, see the sidebar on plug-in
menu. modules or refer to “Plug-in Modules” in the section on “The
Software” in Chapter 6.)
¢ Choose the plug-in module for
your scanner or video source from Import using:[_MicrotekScanner... |
the Import using pop-up menu. Import for...
I:orrectlon
e Click Correction to open the 2 neﬂmme
scanned image as the working /
image. Click Correction to open  Choose the plug-in

the compressed image as  module for your scanner

the working image. or video source.
* Select options in the dialog box sl

i If you click Reference instead of Correction, Cachet will open

your scanned image as a reference image. However, this is
strongly discouraged. A newly scanned image cannot be an
effective reference image since you have not yet corrected and

printed it with Cachet.

e Click OK.
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Scanning—
some tips and guidelines

When you scan a photograph or slide,
you may see dialog boxes containing
options for such settings as resolution,
sharpness, gamma, exposure, or color
balance. Don’t worry if some of these
settings are unfamiliar to you. You don’t
have to change them. The default
settings often work well, and if not, you
can adjust the image once you open it
in Cachet.

However, if you want the best possible
printed results, adjusting some of the
scanner settings—particularly
resolution and gamma—can be very
helpful. Follow these guidelines.

Displaying the Images

Scanning resolution—it depends on
the dimensions and output resolution

Most scanners let you control the
resolution at which you scan an image.
For the best printed results, adjust the
scanning resolution to ensure that the
scanned image contains enough data
for printing at the size and resolution
you plan to use.

You need to consider three factors:

* The width of the original image and
the width at which you plan to print the
final image—for example, 35 mm and 3"

* The resolution you plan to use for the
final output-for example, a 150 Ipi
halftone screen or a 400 dpi continuous
tone printer

* The scaling—the ratio between the
width of the original image and the
width at which you plan to print it—for
example, 2.18 for a 35 mm slide you plan
to print 3" wide

Note that you must have enough space
available on your disk to store the
resulting scanned image—a 3,000-dpi
scan will require more disk space than
a 500-dpi scan.

To calculate the optimal scanning
resolution, do the following:

1. Calculate the output resolution.

This is the resolution you need for your
image at the width you plan to use for
final printing. For halftone printing, the
output resolution is twice the size of the
halftone screen you plan to use. For a
continuous tone device, the output
resolution should equal the device
resolution.

For example, assume you want the final,
printed image to be 3" wide:

« |f you plan to print on an offset press
using a 150 Ipi halftone screen, the
output resolution is 300 dpi (2 x 150).

« |f you plan to print on EFI’s Fiery
ColorLaser, a continuous tone device,
the output resolution is 400 dpi (the
resolution of the Fiery ColorLaser).

2. Calculate the scaling factor.

This is the ratio between the width of
the eventual printed image and the
width of the original image you plan to
scan. If the width of the original is
identical to the width you want to use
for printing, the scaling factor is 100%.
On the other hand, for example, if you're
scanning a 35 mm slide and you want
the printed image to be 3" wide, you
can calculate the scaling factor as
follows:

Scaling _ Width when printed _ 3" 76.2mm_ 218
factor = “Widthof shide _ 35mm  3omm
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3. Calculate the scanning resolution.

Using the output resolution and scaling
factor that you calculated, you can now
determine the optimal scanning
resolution, using the following formula:

Scanning resolution=0utput resolution x Scaling factor

Example. For example, suppose you
want to scan a 35 mm slide. You plan to
print the image at 4-1/2" wide on an
offset press using a 180 Ipi halftone
screen. The calculations are as follows:

Output resolution=2 x 180 = 360 dpi

Scaling factor= A = A ;525'4 =

35mm 32l
Scanning resolution= 360 x 3.27 = 1177 dpi

Displaying the Images

If your scanner has a gamma control,
setitto 2.2. Cachet's reference images
have a gamma of 2.2. Using the same
gamma setting makes it easier to
compare a scanned image with one of
Cachet's reference images.

Exposure and color balance

In most cases, you should avoid
adjusting the exposure and color
balance controls of the scanner. Use
the Cachet tools instead. If the original
slide or negative is extremely bright or
dark, you may lose some detail in the
scanned image. In this case, you may
want to use the scanner controls to
preserve the details.

Sharpness

Some scanners have a sharpness
setting. You may find that you get better
results if you increase the sharpness
slightly—usually one or two steps up
from the default setting.

Scanning negative images

Cachet expects positive digital images.

The plug-in modules supplied with most
scanners can convert from negative to

positive images.

Use scripts to compensate for scanner
“habits”

If you notice that you always have to
make the same kinds of adjustments
when you begin working on an image
you've scanned, your scanner may
have some “habits” that are causing
the problems. You can create a script to
correct these problems automatically
when you first open your images in
Cachet. See the section on “Scripts” in
Chapter 4.




Edit by Reference:
A new way to correct
color images

When you work with
Cachet, you edit by
reference. You use one or
more reference images as
guides while you make
corrections to the
working image.

You start by displaying the
working image and
reference image side-by-
side on the same monitor.
Then, you adjust the
working image until it
looks similar to the
reference image. As you
make corrections, you
compare the overall color
and individual colors in
the working image to
those in the reference
image. If they match on
screen, they'll match
when you print them.

(continued on next page)

Using Cachet

Displaying the Images

Reference Images:

Use them as guides to
color correction, or to

Reference images are digital match specific colors

images that have been color

corrected in Cachet and then
printed with good results using color separations created in
Cachet. You can use such images as guides to adjust your
working image. Because you know how the reference image
appears when printed, you can predict how your working
image will appear when it is printed.

Cachet comes with a set of reference images in digital and
printed form. The printed images are in the Cachet Reference
Image Guide. You can use this book to find images—or parts of
an image—that look the way you want your working image to
look when it’s printed.

You may want to use more than one reference image, and you
can open multiple reference images at the same time. For
example, the overall lighting in one image may be right, but
you want to match a specific tone in another. As another
example, when correcting an image that will appear with
others on a single spread, you might open the other images as
reference images so as to get an idea of the overall color
message of the spread.

When you open an image as a reference image, you cannot
change it. To change an image, you must open it as a working
image. (However, if you change a reference image, the file will
no longer match the printed version, and you will no longer be
able to rely on that image as a reference image.)
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To choose reference When you choose reference images to work with, your goal
images should be to create a visual environment on your screen that

) will help you make good decisions about the color and tone of
* Look through the Cachet your working image. Open as many reference images as you
Reference Image Guide or your need. If necessary, you can adjust the window size and view to
own folder of Cachet prints. isolate parts of the image that are relevant to your task, but be

aware that this may change your perception of specific colors
* Check the lighting of the image. ~ in the image.

* Check overall color balance. Although there are no simple rules for selecting reference
images, perhaps the most important criterion for choosing a

* Check key foreground colors. reference image is the lighting. The lighting in the reference
image should match the lighting in the image you want to

* Check background colors. correct. Is it indoor or outdoor lighting? Is the subject lit from
the front, from behind, from overhead, or from below? Is the

lighting diffuse or highly directional?

The image on the right is a good reference image for the one on the left—
both are outdoor photographs, lit from above, with diffuse lighting.
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Displaying the Images Reference Images

Once you have a good match for lighting, you can consider
other comparisons. Check the overall color balance of the
reference image. Does it have white whites? Neutral grays?
Black blacks? Is it pleasing? Does it “feel right”?

Compare the foreground subjects. They don't have to be the
same, but look for a similar range of foreground colors. Also, if
people are the main subject, you usually choose a reference
image with people so you can compare skin tones. In fact, you
can look for specific skin tones you want to match.

Background color is important, too. You obviously don’t want
to match a photograph with white walls in the background to
one with dark wood paneling. But you may want to use a
reference image that has an overall color cast to give your white
walls a particular mood.

Of course, you may also want to match a color exactly. In that
case, use a reference photograph that has that color, but still
watch for lighting, color balance, and background colors
because all of these factors affect the appearance of any given
color in the photograph.
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To open a reference Cachet comes with an extensive set of reference images.

image Normally, the reference images are copied to your hard disk
when you install Cachet. If you need to re-install them, refer to

* Choose Open from the File menu.  the Start Here guide for information about using the Cachet

Installer.
e Click Reference to open the file
as a reference image. You can also use any file that you have corrected in Cachet and
printed using color separations generated by Cachet. When
* Select the image you want to you choose the Open command, Cachet displays a dialog box
open from the dialog box. that you can use to select the image you want to open:
e Click Open. Select a file to open:
= Hard Disk
D House
O New UP
D 0n a Picnic

D On the Dock
0O Puddle Stomping e

D Sunny Picnic [ open |

D vegetable Basket

Open File For...
QO Correction
Reference

Format: TIFF

File Size: 1,300,240
Created: 3/28/92,11:00 A
Modified: 3/2 100 AM [ See all files

Make sure this option is selected to open the image as
a reference image. It is automatically checked if a
working image is already open on the screen.
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To open a compressed
image as the reference
image

* Choose Import from the File
menu.

* Select a plug-in module from the
dialog box.

e Click Reference to open the file
as a reference image.

 Click Import.

 Select options in the dialog box
that appears.

e Click Open.

Displaying the Images Reference Images

If you have a large number of your own reference images or

if you have a limited amount of disk space, you may find it
helpful to store reference images in compressed format. You
can do so as long as you have a plug-in module to compress
and de-compress the files, such as the Storm Technology
PicturePress plug-in that is included with Cachet. (For details,
see the sidebar on plug-in modules earlier in this chapter or
refer to “Plug-in Modules” in the section on “The Software”
in Chapter 6.)

When you choose Import from the File menu, Cachet displays
a dialog box so you can choose a plug-in module and reference
image to de-compress.

Import using:| Storm JPEG Decompress... » ]

Import for...
|:(.3Correction —\ /
Reference (" cance,,” ] || import |

£
7 7

Click Reference to open Choose the plug-in
the compressed image as  module you want from
a reference image. this pop-up menu.

After you click Import, the plug-in module you selected
displays its own dialog box with any options or settings you
need to select. For information about these options, refer to
the documentation that came with the plug-in module.
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Displaying the Images Orientation:

If your image is upside

down, backwards, or too

You can rotate, flip, or crop a big, you can rotate it, flip
working image in Cachet. For  [RUSUEEOT B
example, if an image is scanned

upside down, you can flip it so
it appears right side up on the screen as you work. Or you may
want to crop an image before you make color corrections and
work only with the part of the image you actually plan to use.

You use the Orientation palette to make these changes.

Flip tools

=7 Rotate tools

Crop Selection L
sk 7 Crop tools
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To flip or rotate an image

* Choose Orientation from the
Image menu.

¢ Click one of the tools to rotate or
flip the image.

Displaying the Images Orientation

You can flip the working image from left to right or top to
bottom. You can rotate an image to change its orientation
from horizontal to vertical or vice versa. You can also turn it
upside down.

Flips the image from left to

right.

Flips the image
from top to bottom.

Rotates the image
90 degrees to the
left.

Rotates the image
90 degrees to the
right.

Rotates the image
180 degrees.

&[]

When you save the image, the new orientation is saved.
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To crop an image

e Choose Orientation from the
Image menu.

e Click the crop tool.
* Click and drag in the working
image to outline the area you want

to keep.

» Click inside the outlined area to
crop the image.

Displaying the Images Orientation

You can crop your working image to remove unwanted parts of
the image. After you click the crop tool, you can use it to

outline the area of the image that you want to keep.

— Click inside the
frame to complete
cropping.

Refer to the size Use the crop tool to Drag the handles to
display for precise outline the area of the  change the size of the
measurements. image you want to outlined area.

keep.

You can drag the handles to change the size of the outlined
area. When you move the pointer inside the outlined area, the
pointer changes from the crop tool to a pair of scissors. When
you click inside the frame with the scissors, the image is
cropped and the window is adjusted to the new image size.

CAUTION:
When you save an image that you have cropped, all the

image data outside the crop marks is permanently

removed from the image file and cannot be restored. You
can use the Undo command immediately after you crop

the image to restore the original image. You can also use
the Revert command to restore the original image if you
have not saved the image since you cropped it. You may

want to save a copy of the image before you crop it.
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Displaying the Images The View Through the
Window:

Scroll, grab, zoom,
You almost always have several —JRYN ERSTRRITTe W (221

windows open when you work  EPPSSASHRRSS|
in Cachet. In addition to a

window for the image you are
correcting, you probably have one or more windows for
reference images.

These windows work like windows in other Macintosh
applications, with scroll bars and boxes for closing and sizing.

In addition, all the Cachet tool palettes have three tools that
change the view in the window to help you work more
efficiently. You use these tools to zoom in and out and to move
the image around in the window. You can also use the
commands in the Windows menu to change the view through
the window.

If you want to change the view permanently, you can rotate,
flip, and crop the image. See the preceding section on
“Orientation” for details.
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To select a window

* Choose the window you want
from the Windows menu.

OR

* Click anywhere in the window.

Displaying the Images The View Through the Window

As in other Macintosh applications, you can click in a window
to bring it to the front and make it active. But if you have
many windows open and you can’t find the window you want,
you can choose it from a list in the Windows menu.

The Windows menu lists all the image windows that are
currently open.
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To move the image around
in the window

e Open a tool palette.
e Click the hand tool.

e Click in the window and drag to
move the image around.

Displaying the Images The View Through the Window

As in any Macintosh application, you use the scroll bars, scroll
boxes, and scroll arrows to change the view of the image in the
window. The scroll bars move the image horizontally and
vertically within a window.

If you want to move the image quickly in any direction, you
can use the hand tool. This tool grabs the image and moves it
as you move the mouse.
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To zoom in or out

* Open a tool palette.

» To magnify the image, click the
zoom-in tool and click the image.
Or choose Zoom In from the
Windows menu.

* To reduce the image, click the
zoom-out tool and click the image.
Or choose Zoom Out from the
Windows menu.

* To select a specific reduction or
magnification, choose Zoom from
the Windows menu and choose
the amount of zoom from the
submenu.

Displaying the Images The View Through the Window

You can magnify the working image to get a close-up view or
reduce it to see more of the image.

You use the zoom-in and zoom-out tools that appear in all the
tool palettes. When you click the zoom-in tool and move the
cursor into a window, it becomes a magnifying glass with a
plus sign. When you click, it magnifies the image. The zoom-
out tool changes the cursor to a magnifying glass with a minus
sign and reduces the image. You can temporarily switch back
and forth between the two tools by holding down the Option
key when either one of them is selected.

= ENRIEE 2N = I

The zoom-in tool The zoom-out tool reduces
magnifies the image. the image.

You can also use the Zoom In and Zoom Out commands in
the Windows menu. These have the same effect as clicking the
image once with the zoom-in and zoom-out tools. If you want
to choose a specific magnification, you can use the Zoom
command in the Windows menu. It displays a submenu with
several possible magnification and reduction factors. You
choose the one you want.
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To change the amount of You can change the magnification and reduction increments

zoom with the Main Preferences dialog box. This change affects both
the zoom tools and all the zoom commands.

* Choose Preferences from the

i — Edit Preference: —
Edit menu. ce Main Preferences:
@® Main [ Ask for a file when Cachet starts
. . . = Folders Lock MultiChoice to image window
e Click Main to display the Main 8 e e = SRR A ?
Preferences. @® Keep click under mouse

(O Center click in window

e Click the zoom step you want. — Zoom Step
/© Additive (%1, #2, ®3, #4...)

3 d Q\noubling (81, #2, B4, 88...)
e Click OK. <
\ [(cancet ] |[ ok |
i N

With this option, you zoom in or out ~ With this option, you zoom in or out
slowly. quickly.
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To control the view when
you zoom

* Choose Preferences from the
Edit menu.

* Click Main to display the Main
Preferences.

e Click the zoom type you want.

e Click OK.

Displaying the Images The View Through the Window

When you use the zoom tools to zoom in or out, Cachet
normally keeps the spot you click in the same relative position
within the window. However, you can tell Cachet to center the
spot you click in the window each time you zoom in or out if
you prefer to work this way.

You use the Main Preferences dialog box to set these options:

— Edit Preference: — =
Main Preferences:

@ Main 3 Ask for a file when Cachet starts
O Folders [ Lock MultiChoice to image window
O Performance — 2oom Clicks

Keep click under mouse
/] QCenter click in window

— 2ogm Step
itive (11, 82, #3, n4...)
O Doubling (11, #2, #4, 18...)

/ \ ((cancer ] [[ ok |

Y
Use this option to keep the spotyou  Use this option to center the spot
click in the same position as you you click in the window each time
enlarge or reduce the image. you zoom in or out.
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To increase or decrease
the amount of detail

* To get maximum detail, choose
File Detail from the Windows
menu.

* To get the best possible
resolution for the current
magnification, choose Zoom
Detail from the Windows menu.

* To use the default amount of
detail, choose Standard Detail
from the Windows menu.

Displaying the Images The View Through the Window

When you open an image file, Cachet builds a subsampled
version of the image, called the internal model. Cachet
displays the internal model as you adjust the image
interactively using the tool palettes. Initially, the internal
model is quite compact, but it usually provides adequate
resolution on the screen for you to make most color
corrections.

However, if you are working with very fine details or if you are
working in a magnified view, you may need better resolution
on the screen than you get with the default size of the internal
model. You can change the size of the internal model to get the
amount of detail you want by choosing the appropriate
command from the Windows menu.

Standard Detail When Standard Detail is checked, Cachet uses
the default size of the internal model.

File Detail When you choose File Detail, Cachet re-builds the
internal model using all the data in your image file. This
provides the maximum possible resolution. (If your image file
is relatively small, Cachet automatically uses all the image data,
regardless of whether you select Standard Detail or File Detail.)

Zoom Detail When you choose Zoom Detail, Cachet re-
samples the image file and re-builds the internal model to
provide the best resolution possible at the current
magnification. If you have zoomed out, this generally reduces
the number of pixels in the internal model and therefore
improves performance. If you have zoomed in, this generally
increases the number of pixels in the internal model, thereby
improving resolution.
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Displaying the Images The View Through the Window

If you zoom in or out after you choose Zoom Detail, the
internal model will still be optimized for the previous
magnification level. Therefore, to maintain optimum detail,
you may want to choose Zoom Detail again after you zoom in
or out.

Each time you change the amount of detail, Cachet re-displays
the image at 1X magnification of the new internal model. If
the image file does not contain sufficient data for the current
zoom level, Cachet switches automatically to File Detail. In
this case, the image is displayed at 1X magnification for File
Detail, which may differ from the zoom level you were using
when you chose Zoom Detail.
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To get information about
an image

e Click the window with the
image to make it active.

* Choose Get Info from the File

menu.

Displaying the Images The View Through the Window

You can get some basic information about the image in the
active window with the Get Info command. This information
is useful for managing your disk space.

File Information
File Name: Puddle Stomping
File Folder: Hard Disk 2:User Images:
File Size in Bytes: 1,297,065
File Dimensions: B80Sx537
File Type: TIFF o
L

/
The file dimensions are shown in pixels.
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Using Cachet Getting the Overall Color Right

With Cachet, you begin color correction by adjusting the overall appearance
of the image.

You can correct for problems in the original photographic process—for example,
underexposure or overexposure or a mismatch between the type of film and the
lighting. You can also change the color properties to achieve a particular effect.

1o make these changes, you use the tools in two palettes. Start with the
Exposure & Tone palette to correct exposure problems and adjust the overall
tone of the image. Then, if necessary, go on to the Color palette to change color
properties to meet your artistic goals.

With both of these palettes, you can also use a special tool called MultiChoice.
It turns color correction into a multiple-choice exercise, displaying six variations
of an image for you to choose among. Its a fast, visual way to work.

This chapter explains how you work with the tool palettes—including the
suggested order for making corrections. Then it shows you when and how to use

each of the individual tool.
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Getting the Overall Color Right The Tools:

Cachet has tools for

correcting exposure

When you work with Cachet, problems, adjusting tone,
you adjust the overall color and enhancing the
appearance of your working overall color

image by first correcting for

any problems due to improper
exposure of the original. Then, you adjust the overall tone of
the image. Finally, you can adjust overall color properties such
as saturation and color cast.

The tools for making all these overall corrections are organized
in two palettes—the Exposure & Tone palette and the Color
palette. These palettes use two different color systems, or color
spaces, for representing color. By using different color spaces
to represent color corrections, Cachet gives you more flexibility
and control for getting the color exactly the way you want it.
Here’s how you use these palettes.

First, correct for exposure problems

Today’s films are designed to give excellent color reproduction
when they are properly exposed. The most common problems
in color photography, though, are exposure problems. The first
task of color correction, then, is to adjust the image to com-
pensate for errors in exposure—including an incorrect F-stop,
shutter speed, or color filter, or a mismatch between the type
of film and the lighting conditions. You use the Exposure &
Tone palette to correct exposure problems.
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Getting the Overall Color Right The Tools

Second, adjust tone

Tone adjustments are those that affect the brightness of the
image. Tone problems usually show up as a loss of detail in the
highlights or shadows of your image. You also use the
Exposure & Tone palette to adjust the overall tone of an
image.

Third, adjust color properties, if necessary

Color correction is ultimately a subjective process. It has to do
with taste and preference. So Cachet also provides the Color
palette, a group of tools you can use to adjust three color
properties—saturation, color cast, and lightness—to achieve
artistic goals. These tools also work well for adjusting the
gamut of the image to match the gamut of your printer or
reproduction method (see “Color Checks” in Chapter 5). You
should use the color tools only after you have made the basic
corrections for exposure and tone problems.
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To correct exposure
problems and adjust
the tone of the image

* Choose Exposure & Tone from
the Image menu.

¢ Use the exposure slider and
color filter to correct exposure
problems.

* Use the remaining sliders to
adjust the tone of the image.

* Use the Check and Show buttons
to check for tone clipping as you
make corrections.

Getting the Overall Color Right The Tools

The Exposure & Tone palette has eight tools for correcting
problems that result from poor exposure and improper lighting
conditions and for adjusting the overall tone of the image.

Because this palette is the starting place for making color
corrections, it opens automatically when you first open a work-
ing image. You can also choose it from the Image menu.

First, use these
tools to correct for
improper exposure
in the original
photograph.

Then use these
tools to adjust the
tone of the image.

The numbers
suggest the degree
of change

Click here to
change one step at
a time.

Drag this bar to
change settings
quickly.

These buttons
check for tone

clipping.
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Getting the Overall Color Right The Tools

You can use the Check and Show buttons to check for tone
clipping as you make changes with the tools in this palette.
When tones are clipped, you lose details in highlights or

shadows. See “Tone Clipping” later in this chapter for more

details.

You can use the Reset button to reset all the tools in this
palette to zero. The image then appears as it did when you
opened the palette. If you save the image and then make
additional changes without switching to another palette, the
Reset button displays the image as it appeared when you last
saved it.

You can also hold down the Command key and click an
individual tool to reset it to zero without resetting the other
tools.

Cachet automatically closes the Exposure & Tone palette when
you choose another palette from the Image menu.
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To adjust color properties  The Color palette has three tools that you can use to enhance
the color in your image. Here, you are not necessarily trying to

* Choose Color from the Image correct a problem. Instead, you may want to create a particular

menu. mood or suggest a time of day or just make an image look
better than it does naturally.

* Adjust the settings for saturation,

color cast, and lightness to When you use this palette, you can think of color as having
enhance the color in the working ~ two components: chrominance and luminance. Chrominance
image. is the chromatic component, typified by the difference

between green and blue, for example. Luminance is the
achromatic component—the difference between light blue and
dark blue, for example.

You move the color
indicator in the
color map to
change the color
cast.

You move the
sliders to change
the saturation or

& ‘ lightness.

(| — (| ()

As with the Exposure & Tone palette, you can use the Reset
button to reset all the tools in this palette to zero. Hold down

k the Command key and click an individual tool to reset it to
zero without resetting the other tools.

Cachert automatically closes the Color palette when you choose
another palette from the Image menu.
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Getting the Overall Color Right Multiple Choices:

You can use the

MultiChoice window to

If you're not sure what's wrong  JRIEGERUIRTNEGE R
with your image—if you don’t [ CURIITE KA A
know whether the color and visually

balance is too green or too

blue, for example—it may be
easier to choose from several variations than to adjust the
settings in a tool palette. The MultiChoice window gives you
this option.

You can use the MultiChoice window to make any of the
corrections you can make with the Exposure & Tone palette or
the Color palette. The window displays six variations of the
working image at a time. You choose the one that best matches
your reference image.

You can also customize the MultiChoice window to fit your
needs. You can change the size of the window and the images
in it. You can change the layout of the images and adjust the
degree of change between each variation. You also decide
whether you want the MultiChoice window to show the same
view as the working image.
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To choose from multiple
images

* Choose Color or Exposure & Tone
from the Image menu.

* Choose MultiChoice from the
Tools menu.

e Choose the tool you want to use
from the pop-up menu in the
lower-left corner of the
MultiChoice window.

e Click the image in the
MultiChoice window that best
matches your reference image.

Getting the Overall Color Right Multiple Choices

The MultiChoice window displays six variations of the
working image. When you first open this window, it shows
variations in exposure if you are using the Exposure & Tone
palette. If you are using the Color palette, it shows variations
in color cast.

You can use a pop-up menu in the lower-left corner of the
window to switch to a different tool. Each time you choose a
tool, the MultiChoice window displays six new variations of
the working image for that tool. You click the one you think is
the best match for the reference image.
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When you click one
of the MultiChoice
images, Cachet
changes the
working image to
match your choice,
and the

MultiChoice
window displays six
new choices.

Getting the Overall Color Right Multiple Choices

When you click one of the images in the MultiChoice window,
Cachet changes the working image to match your choice
exactly and then displays six new variations of the modified
working image in the MultiChoice window. You continue
selecting images until you get the match you want. At any
point in the process, you can also use the tools on the palette,
either to refine corrections made with the MultiChoice
variations, or to see combined effects.

When you click the
lower-left corner, a
pop-up menu displays
the tools.

——
Click and drag hereto  Click and drag here to
change the size of the  change the size of the
images within the window.

window.
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To change the layout of
MultiChoice images

* Choose Layout from the Tools
menu.

 Choose Grid, Row, or Column
from the submenu.

Getting the Overall Color Right Multiple Choices

Cachet normally displays the MultiChoice images in a grid of
two rows and three columns.

* When you're working with the color filter, the six images
each represent one step toward each of the six color handles.

* When you're working with one of the other tools, the
variations form a clockwise progression from upper left to
lower left. The current settings for the working image fall
between the third and fourth image in the window.

You may prefer to view the choices as a linear progression, say,
from light to dark or from high contrast to low contrast. In
this case, you can rearrange the images in a single row or
column to see this progression more clearly. The current
settings still fall between the third and fourth images. Or you
may simply change the layout of the images to use the space
on your screen more efficiently.

-

A row is 6 horizontal You can also choose a  The current settings

images. column of 6 vertical for the image always
images or the fall here—between
standard grid of 2 the third and fourth

rows and 3 columns. image in the window.
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To adjust the degree of
variation among images

e Choose Step from the Tools
menu.

 Choose Small, Medium, or Large
from the submenu.

Getting the Overall Color Right Multiple Choices

The MultiChoice window normally shows six images that vary
moderately. However, you can change the degree of variation,
called the “step,” between each image.

For finer control of the variations, choose Small. For a greater
range of choice, choose Large.

The actual percent change represented by a step varies with
each tool. You can compare the slider settings before and after
you choose a MultiChoice image to determine the exact
numerical change.

Tools

MultiChoice M

Step 4 Small
Layout »|vMedium
Large

Gamut Alarm -
Color Met
PR ® Colors

Choose the degree of variation you
want between images in the
MultiChoice window.
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To lock MultiChoice
views to the working
image

* Choose Preferences from the Edit
menu.

» Click Main to see the Main
options.

» Click the option for locking
MultiChoice to the image window

to check or uncheck it.

* Click OK.

Getting the Overall Color Right Mudltiple Choices

As you work, you may change the size of the working image,
zoom in or out, or scroll to a different part of the image. You
usually want the view of the images in the MultiChoice
window to match the view of the working image. That is, if
you zoom in on the working image, the variations in the
MultiChoice window should also appear zoomed in.

Sometimes, though, you may want to continue to see the
entire image in one window, even though you're looking at
only part of the image in the other window. You can lock the
MultiChoice images to the working image or unlock it to meet
your needs.

— Edit Preference: —

Main Preferences:

@® Main [ Ask for a file when Cachet starts
O Folders Lock MultiChoice to image window
O Performance — 2oom Clicks

@® Keep click under mouse
O Center click in window

— Zoom Step
@ Additive (11, 82, ®3, vd...)
O Doubling (11, K2, 14, #8...)

/ ((cancet ] [ ok ]
/7

When this option is checked, the view of the images in the MultiChoice
window matches the view of the working image.
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The Exposure Tools—

A Quick Glance

Cachet has two tools for solving If the original is underexposed
problems that occur in the original
photography—the exposure tool and
the color filter.

* The exposure tool compensates for ' %
improper shutter speed and f-stop. It's

the tool to use if your original is over- or

underexposed. The best way to tell if a

photograph is incorrectly exposed is to

look at the original negative or slide. s S %
A negative is too light when it's

* The color filter corrects for color underexposed. It looks “thin.”
balance problems that occur when the
wrong combination of lighting, film, and
camera filter are used. Besides looking
at the original negative or slide, the best
way to tell if an image has color
balance problems is to compare it on-
screen to a reference image with good
color balance.

If the original is overexposed

=

An overexposed negative is too
dark.

Getting the Overall Color Right

A slide is too dark when it’s under-
exposed. You need to increase the
exposure with the exposure tool.

An overexposed slide is too light.
You need to decrease the exposure
with the exposure tool.
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If the color balance is wrong If you don’t have the original

Compare your scanned image to a
reference image with similar lighting
and color composition. If your image is
lighter overall, decrease the exposure.
If your image is darker overall, increase
the exposure.

Also, errors in scanning can sometimes
produce an effect similar to under- or

Blue tints often result from using To correct a blue tint, overexposure. If the original looks good,
indoor film or filters outside. drag the color indicator but the on-screen image is lighter or
away from blue darker than your reference image, use

the exposure tool to match the overall
lightness before you make other
adjustments.

Without the original, it is very difficult to
ascertain whether your scanned image
has an exposure problem. Therefore,
you may prefer to use the midtones,
highlights, and shadows tools instead of

v -- - . the exposure tool.
Fluorescent lighting often produces  To correct a green tint,
a green tint. drag the color indicator

away from green.

Indoor photographs, taken with To correct a yellow-orange
daylight film may turn out yellow- tint, drag the color indicator
orange. away from yellow-orange.
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Getting the Overall Color Right Exposure:

Adjusts the brightness of

an image that is

When you take photographs, overexposed or
exposure is controlled by the underexposed
combination of the f-stop and
the shutter speed. If this

combination is not right for the lighting conditions, the

resulting image is overexposed or underexposed.

You can use the exposure tool in Cachet to compensate

for incorrect f-stop and shutter speed. This tool works best
when you have the original image—such as a transparency—
and can see that it is overexposed or underexposed. If the
original is correctly exposed, you should not need to use the
exposure tool.

Always make exposure corrections before you make
brightness corrections with other tools such as the midtones
tool or the lightness tool in the Color palette. To make
exposure corrections, choose a well-exposed reference image
with similar lighting and subject matter.

Exposure Problems—What You See
Overexposed: The original slide is too light. (If you're

working with a negative, it’s too dark.) You need to
decrease the exposure.

Underexposed: The original slide is too dark. (An
underexposed negative is too light.) You need to
increase the exposure.
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To correct for
overexposure or
underexposure

* Choose Exposure & Tone from
the Image menu.

* Move the exposure slider to left
or right to decrease or increase
the exposure.

Getting the Overall Color Right Exposure

The working image shown here on the left is underexposed.
The image is uniformly too dark compared to the reference

image on the right.

Working image Reference image

When you increase the exposure, Cachet changes the image to
make it appear to have been taken at a lower f-stop or a slower
shutter speed. The result is a brighter image.
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Getting the Overall Color Right Color Filter:

Adjusts the color balance

of an image

Color balance is what makes

the colors of an image look

natural or unnatural. Colors are
balanced when anything that appears gray or neutral in the
original subject also appears gray or neutral in the image.

Color balance problems usually occur when the original
photograph was taken with film that didn’t match the lighting
conditions. For example, when films designed for daylight are
used to photograph scenes lit by fluorescent lights, the result is
usually a photograph with a greenish or yellowish tint.

Experienced photographers avoid these problems by using
filters. But you can compensate for film and filter errors by
using the color filter in Cachet, which acts like the appropriate
set of camera filters.

Correcting color balance may be most important when you're
working with several photographs of the same subject, taken
under different lighting conditions. You want the color balance
to match when they appear next to each other on a single page.
Look for a reference image that has good neutral tones.

Poor Color Balance—What You See

Overall distortion: The image appears tinted with a parti-
cular hue. Typical color casts are green-yellow, blue, and
red-orange. Choose a filter of the complementary color.

Local distortion: Some colors in the image do not match
the color of the real-world objects they illustrate. They are
too red, too blue, or too green, for example. As with overall
distortion, choose a filter of the complementary color to
correct the overall image. If you want to correct individual

colors, see Chapter 3.
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To adjust color balance

 Choose Exposure & Tone from
the Image menu to display the
color filter.

» Click the color handles around
the color filter to shift the color
balance a little at a time.

* Click anywhere in the color filter
to select a specific filter color.

¢ Drag the color indicator in the
color filter to monitor the change
as you move.

Getting the Overall Color Right Color Filter

Here the working image on the left is tinted blue, probably as
a result of a mismatch between the film and the lighting

conditions.

To achieve the same color balance as the reference image on
the right, you need to use a filter of a complementary color—
yellow, in this case. Complementary colors always appear
opposite each other on the color filter, so you can just drag

the color indicator away from the dominant color tint.

// The color indicator
shows the amount
I of correction. You
can drag it to
change the color
balance. Or just

Color Filter

click where you
want it.

Clicking the color

handles shifts the

color incrementally.

You can also use the color cast tool in the Color palette to
change the overall tint of an image. See “Color Cast” later
in this chapter.
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The Tone Tools—
A Quick Glance

All photographs have a range of tones
from dark to light. Problems with tone
arise when this range is too wide for
the printing process or too narrow to
fully reproduce all the details in the
image. Or they may result from a
distortion in the range of tones—too
many dark tones compared to light
tones, for example.

Cachet has six tools for correcting tone
problems.

* The black point and white point tools
adjust the end points of the range to
make the best use of the printing
process.

= The contrast tool adjusts the ratio of

the brightest tones to the darkest tones.

= The midpoint, highlights, and
shadows tools each change the
brightness of the image in different
areas.

Getting the Overall Color Right

If the image lacks crispness or looks dull

M’

r.!’

¥s

When the black point is too low,
there is little or no black in the
image. To get crisp blacks,
increase the black point setting.

When the white point is too low,
the highlights are muddy and dark.
For cleaner whites, increase the
white paint setting.

If the main subject is too dark or too light

B’
o o

3

i.

A m,a

When the midtones setting is too
high, the image overall appears
washed out. Detail is lost.

When the midtones setting is too
low, the image overall is too dark.
Detail is lost in the darker areas.
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If the image looks flat or stark

When the contrast is too low,
there’s not enough difference
between the darkest and lightest
tones, and the image looks flat.
Increase the contrast with the
contrast tool.

Getting the Overall Color Right

When the contrast is too high,
there are lots of very light and very
dark tones, but few midtones. The
image looks stark. Decrease the
contrast.

If details get lost in the shadows and highlights

When highlights are too bright,
details get lost in the light parts of
the image. You may be able to
recover them by decreasing the
brightness with the highlights tool.

Details also get lost in dark
shadows. Increase the brightness
with the shadows tool to bring out
these details.

You can use the tone tools in whatever
order you like. However, the best

results are usually obtained if you make
tone adjustments in the following order:

* First, adjust the white point and black
point if the image lacks crispness or
looks dull.

« Second, adjust the midtones if the
main subject is too dark or too light.

* Then, adjust the contrast if the image
looks flat or stark.

* Finally, adjust the highlights and
shadows if details are lost in those
areas.

Clipping Alarm

wh{ek | Show |

« BV

Tip:

Use the tone clipping buttons to
locate areas of pure white and
pure black. You may lose detail in
these “clipped” areas. As a rule,
you get the best printed results
when just a few tones—nboth light
and dark—are clipped.
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Getting the Overall Color Right White and Black

Points:

Adjusts the point where
Photographs have a range of light tones become white

tones from dark to light. You and the point where dark
can increase or decrease the

tones become black
variation in tones by adjusting

the end points of this range.
When you adjust the white point, you are adjusting mainly the
light end of the range. Changing the dark point adjusts mainly
the dark end of the range.

Problems with end points often result from improper scanner
settings. The scanned image doesn’t make good use of the
available range of tones. Or you may simply want to adjust
white and black point to make use of the entire dynamic range
of the printing process you are using.

Often, white and black point problems look like contrast or
brightness problems. However, the tools for correcting contrast
and brightness can’t correct end point problems. So it’s best to
adjust the end points before you adjust brightness and contrast
settings.

For end point adjustments, use a reference image that has good
detail in the light and dark areas. It is very difficult to make
good end point adjustments if you rely only on comparing the
working and reference images on screen. As you adjust the end
points, use the Check and Show buttons to check your image
for clipping. As a rule of thumb, you want to adjust the end
points point just until colors begin to be clipped. See “Tone
Clipping” later in this chapter for more information.
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White and Black Point Problems—What You See

Low white point value: The image lacks crispness.
The highlights appear muddy or dark. You see little or
no pure white. You need to increase the white point
setting.

High white point value: The highlights are solid
white and devoid of detail. Too much of the image is
white. You cannot compensate for lack of detail by
changing the white point, but you can get more ink
coverage (less pure white) by lowering the white point
setting. You may be able to get more details by re-
scanning the original photograph or slide with a lower
exposure setting on your scanner.

Low black point value: The image lacks crispness.
The shadow areas of the image may appear washed out.
You see little or no black. You need to increase the
black point setting.

High black point value: The image is dark. You see
too much black but little detail in the dark areas of the
image. Cachet cannot recreate detail that was lost in
the scanning process, so you can rarely improve an
image by lowering the black point setting. You may be
able to get more details by re-scanning the original
photograph or slide with a higher exposure setting on
your scanner.
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To adjust the white point

¢ Choose Exposure & Tone from
the Image menu.

* Move the white point slider to
the left or right to decrease or
increase the white point setting.

Getting the Overall Color Right White and Black Points

This gray scale shows what happens when you change the
white point from low to high. On the left, the setting for the

white point is low, and you see many shades of gray, most of
which are dark. On the right, the setting is high, and there are
fewer shades of gray, most of which are light.

The lower bar shows the shift The lower bar shows the shift
to gray when the white point is to white when the white point is
too low. too high.

Here's the same comparison for a color photograph.
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To adjust the black point

* Choose Exposure & Tone from
the Image menu.

» Move the black point slider to the
left or right to decrease or
increase the black point setting.

Getting the Overall Color Right White and Black Points

Here the gray scale shows what happens when you change the
black point from high to low. On the left, the setting for the
black point is high, and you see a lot of black and few shades
of gray, most of which are dark. On the right, the setting is
low, and there are many shades of gray, all of which are light.

The lower bar shows the shift The lower bar shows the shift
toward black when the black away from black when the black
point is too high. point is too low.

Here’s the same comparison for a color photograph.
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Contrast o
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Getting the Overall Color Right Contrast:

Adjusts the brightness of

light tones compared to
Contrast is the ratio between the brightness of dark
the brightness of the light and  JRGHTS
dark regions in an image. For

example, on a bright sunny
day, the sun provides a bright source of direct light with harsh
shadows. In such lighting conditions, contrast is high. On a
snowy overcast day, even though the brightness may be high,
the light is diffuse, so the contrast is low.

Appropriate contrast is defined by the context of the picture.
High and low contrast are not necessarily good or bad. High
contrast is a problem primarily when the image looks too
harsh for the subject and details are lost in both highlights and

shadows. Low contrast is a problem when the image looks dull.

If contrast is the major problem in your image, choose a
reference image that matches the lighting situation in your
photograph. Don't try to match the contrast in a sunny
snowscape to the contrast in a woodland setting, for example.

Contrast Problems—What You See

Too much contrast: The image looks too harsh. You
see very dark and very light tones in the shadows and
highlights respectively but few midtones anywhere. You
lose detail in the shadows and highlights. You may
need to reduce the contrast in the image as a whole.

Too little contrast: The image looks dull and flat. You
see a predominance of midtones with few highlights or
shadows. You may need to increase the contrast in the
image as a whole.



Using Cachet

To adjust contrast

* Choose Exposure & Tone from
the Image menu.

* Move the contrast slider to the
left or right to decrease or
increase the contrast.

Getting the Overall Color Right Contrast

The contrast in the working image on the left is too high. It
lacks detail in the shadows, which are too dark, and in the
highlights, which are too light. Notice the hard edges,
particularly around the faces.

.

When you decrease the contrast, Cachet reduces the variations
in brightness across dark and light tones.

The transitions between light and
dark are softer when the contrast
is reduced.

You generally get the best pictures with the highest possible
contrast that does not lose detail in highlights and shadows.
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Getting the Overall Color Right Midtones, High] ights,
and Shadows:

Adjusts the brightness
If the exposure of an image is and detail of the image
correct, the brightness of the

image should match the
brightness of the original subject. However, you may still find
that the image is a little lighter or darker than you like,
primarily due to the subject matter.

You can use the midtones tool to adjust the brightness when
you want the overall image to appear brighter or darker,
primarily in the midtones. Use a reference image that has the
quality of brightness you want.

You can also use the highlights and shadows tools to bring out
details that are lost in shadows and highlights—or to hide
details you don’t want to show. Choose a reference image with
the amount of detail you want in the highlights and shadows.
The reference image should also have good overall contrast for
the subject. (Of course, the highlights and shadows tools

cannot bring out details that were lost in the scanning process.)
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Brightness Problems—What You See

Too light overall: The colors in the image are pale.
The overall image is light, but the image has sufficient
detail and a complete range of tones. You need to
reduce the midtones setting.

Too dark overall: The image is dark. It looks like a
scene viewed through dark glasses. Details vanish in the
dark areas of the image. You need to increase the
midtones setting.

Problems with highlights: The brightness of the
overall image is good, but you're losing detail in the
highlights. You need to decrease the highlights setting.
If the details in the highlights are distracting, you can
hide them by increasing the highlights setting.

Problems with shadows: The brightness of the overall
image is good, but you're losing detail in the shadows.
You need to increase the shadows setting. If details in
the shadows are distracting, you can hide them by
reducing the shadows setting.
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To adjust brightness in the
midtones

* Choose Exposure & Tone from
the Image menu.

* Move the midtones slider to the
left or right to decrease or
increase brightness in the
midtones.

Getting the Overall Color Right Midtones, Highlights, and Shadows

The working image on the left is dark compared to the
reference image on the right. Perhaps the day was a litde

stormy.

Here, the image appears too dark
overall.

When you increase the brightness, Cachet lightens the
midtones of the image. When you decrease brightness, Cachet
darkens them.

Here, the midtones are noticeably
brighter.
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To adjust brightness
in the highlights

* Choose Exposure & Tone from
the Image menu.

* Move the highlights slider to the
left or right to decrease or
increase the brightness in the
highlights.

Getting the Overall Color Right Midtones, Highlights, and Shadows

Sometimes you may want to increase the detail in the
highlights of an image without changing the overall brightness
of the image. For example, you can improve the detail in the
young man’s scarf by decreasing the highlights setting.

When you decrease the highlights setting, the light tones
appear a little darker, increasing the detail in the highlights.
When you increase the highlights setting, the light tones
appear a little brighter, decreasing detail.
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To adjust brightness
in the shadows

* Choose Exposure & Tone from
the Image menu.

* Move the shadows slider to the
left or right to decrease or
increase brightness in the
shadows.

Getting the Overall Color Right Midtones, Highlights, and Shadows

Sometimes, details of the photograph are lost in shadow, as the
outline of the woman'’s legs and the folds in the man’s pants.
You can increase the brightness in shadow areas to gain detail.

Here, some details are lost in the
shadow areas.
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Getting the Overall Color Right

When you increase the shadows setting, the dark tones become
a little lighter, so you see more details. When you decrease the
shadows setting, the dark tones become darker, so you see

fewer details.

e =]

With a higher shadows setting, the
details are more visible.
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Getting the Overall Color Right Tone Cllppll‘lg:

Locates the pure whites

and pure blacks in an

As you make adjustments to image
your working image, you may

want to see which areas of the
image are pure white or pure black. Most images will have
some pure whites and blacks before you make any
adjustments. As you work with the tone tools—especially
white point and black point—you may increase or decrease the
amount of pure white and black. This can result in clipping, a
situation in which light tones become white and dark tones
become black. Clipping generally results in some loss of detail
either in the highlights or the shadows of the image.

Cachet’s Exposure & Tone palette has Check and Show
buttons that you can use to identify areas of pure white and
pure black. These areas may have lost detail without your

noticing it.

You can also use the Check and Show buttons to gauge the
amount of white and black point adjustment you need to
make. In general, it’s best to adjust these end points just until
tones start to be clipped. Clipping can actually have a positive
effect on the image, so long as only less important regions of
the image are clipped.

The Check button analyzes
the image to locate areas of
pure white and pure black.

/
Clipping Ala The Show burrqn
Chgek Shew shows these clipped
areas.
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To check for tone clipping  Here, changes in the exposure and tone of the working image
have resulted in some clipping of colors in the highlights in the
* Choose Exposure & Tone from water and on the man’s head.

the Image menu.
[] Black indicates

areas where light
tones have been
clipped.

* Click the Check button.

» Click and hold the Show button
to display clipped tones.

White indicates areas where dark
tones have been clipped.

If you are concerned about the loss of detail due to tone
clipping, you can readjust the tones with the tools in this
palette.
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The Color Palette—
A Quick Glance

Cachet's Color palette is for the artist in
you—the one who wants to adjust the
world of color to make it more spec-
tacular than it already is. It is also very
useful for adjusting the gamut of your
image to the gamut of your target
printer. (See Chapter 5, “Printing,” for
more information.)

The Color palette has three tools—

the saturation tool, the color casttool,
and the lightness tool. With these tools,
you can change the color properties of
the overall image to meet your artistic
objectives. You can also change the
color properties of individual parts of
the image with a corresponding set of
tools in the Selective Color palette. See
Chapter 3 for details.

Getting the Overall Color Right

If you want a different mood

A color cast can make an image
look warm and inviting. You click

a warm color—yellow or orange—
in the color cast tool fo achieve
this warmth.

A cool color cast can suggest
reserve—or maybe even an
approaching storm. You click a
cool color—blue, green, or
purple—from the color cast tool
to get that mood.




Using Cachet Getting the Overall Color Right

If you want more vivid color

- i

A

This image is undersaturated. But don’t increase the saturation

The dock and palm trees look too much. Otherwise the image

especially pale. Increase the may look unnatural, as it does here.

saturation to make them more Also, you may not be able to

vivid. reproduce very saturated colors in
the printing process.

If things get too dark or too light

When you change color cast and Or use the lightness tool to lighten
saturation, an image may get too an image that’s a little too dark.
dark. You can use the lightness tool

to lighten things up.
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Getting the Overall Color Right Color Cast:

Creates a tint over the

entire image

A color cast is an overall tint

over an image. Sometimes such
a tint results from exposure problems and is undesirable. In
this case, you can use the color filter described earlier in this
chapter to correct the color balance.

Sometimes, however, you may simply want to change the
color cast of an image for artistic purposes. Changing the

color cast can change the mood or ambiance of the image.

For example, a slight orange cast is typical of light conditions
in the early morning. You can suggest early morning by adding
such a cast to your image. You can also use the color cast tool
to correct an undesirable color cast that results from the
subject matter itself.

When you're working with color cast, choose a reference
image that has the overall mood you want to achieve. Using a
reference image will help you judge how much mood—that is,
how much color cast—to add.

Color Cast Problems — What You See

Undesirable tint: The overall color of the image is
unappealing or unnatural. Objects that appear white in
reality appear tinted in the image. You need to shift the
color cast to a more neutral or more desirable tint. In
general, it’s best to use the color filter to solve this
problem. However, in some cases, you may get the
result you want with the color cast tool.

The wrong mood: The light in the image suggests
morning when you want to suggest high noon or vice
versa. Or the image may simply be too ordinary. You
can enhance it by shifting the color cast to create the
mood you want.
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To shift the color cast of
an image

 Choose Color from the Image
menu.

* To add a specific color cast,
click on a similar color in the
color map.

Getting the Overall Color Right Color Cast

Suppose you want to suggest a bright, sunny day when your
photograph was actually taken under overcast skies. The
reference image on the right, which was taken under bright
sunlight, suggests that you need to shift the color of the
working image on the left toward yellow.

When you shift the color cast, Cachet changes the hue and

saturation of every pixel in the image, without changing the

lightness.

Changing the color cast shifts the
chrominance—the hue and
saturation—of every pixel.
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Saturation

Getting the Overall Color Right Saturation:

Adjusts the purity of

color in an image

Changing the saturation affects

how colorful an image appears
to be. In saturated images, the colors are full-strength or pure.
In undersaturated images, the colors look diluted or pale.

Like many other color characteristics, the desirable saturation
depends on your goals for the photograph. People generally
respond better to saturated images. However, keep in mind
that too much saturation may make your image look unnatural
and print unreliably. You generally get the best results by using
the highest saturation you can without getting undesirable
effects such as unprintable colors. (To check the printability of
your colors, see “Color Checks” in Chapter 5.)

For saturation adjustments, use a reference image with the
same range of colors and tones as your image. It’s hard to
compare the saturation of a predominantly blue or green image
with that of a predominantly red or orange image.

Saturation Problems—What You See

Oversaturated: The colors in the image look wet,
gaudy, or unnaturally intense. You see few details in
colored areas—they appear as “blotches.” You need to
decrease the saturation.

Undersaturated: The image looks pale, gray, or pastel.
You don't see any vivid colors. You may want to
increase the saturation.
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To adjust saturation

 Choose Color from the Image
menu.

* Move the saturation slider to the
left or right to decrease or
increase the saturation.

Getting the Overall Color Right Saturation

Here the working image on the left is undersaturated
compared to the reference image on the right. It looks more

gray than colorful.

When you increase the saturation, the colors become less gray
and more colorful.

Increasing saturation gets rid of the “gray day” feeling.
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Adjusts the overall

lightness of the image

Lightness has no hue and

saturation. It has only black,
gray, or white values. It is the component that makes light blue
different from dark blue, for example. If you think of color as

§ having chromatic and achromatic components, lightness is the
achromatic component.

In Cachet, the lightness tool adjusts the overall lightness of the
image. If you have made the proper adjustments with the
exposure and tone tools, you shouldnt need to use the
lightness tool to correct for problems in the original. But you
may need to use it to control how light or dark the image
appears as you change the color cast and saturation. The
lightness tool may be particularly useful in combination with
the saturation tool for correcting out-of-gamut colors. (See

“Color Checks” in Chapter 5.)

Because the lightness tool is really an aid to help you achieve
the saturation or color cast that you want, you don’t need a
special reference image to adjust the lightness. Use the same
image you use for adjusting saturation and color cast.

Lightness Problems—What You See

Too light: The colors in the image are pale. The overall
image is light, with more detail in the dark tones than
the light tones. You need to reduce the lightness (even
though you may lose some detail in dark areas).

Too dark: The image is dark for the subject matter.
Details are difficult to see, especially in the dark tones.
You need to increase the lightness (although you may
lose some detail in the light areas).



Using Cachet Getting the Overall Color Right Lightness

To adjust overall lightness  For the best results, you should generally make overall lightness
adjustments using the midtones tool in the Exposure & Tone
* Choose Color from the Image palette. Generally, you'll only need to use the lightness tool to
menu. make very slight adjustments to the overall lightness or to com-
pensate for changes you've already made with the saturation or
* Move the lightness slidertothe  color cast tools. The lightness tool may also be helpful if you
left or right to decrease or decide to make manual adjustments to out-of-gamut colors.
increase the overall lightness.
In the image on the left, the saturation has been corrected, but
some of the details in the dark areas have been lost. The overall
image also looks a little dark.

When you increase the lightness, Cachet shifts the lightness of
every pixel by the same amount.

The lightness tool works with the
saturation and color cast tools to
control the same kinds of problems
as the midtones tool in the
Exposure & Tone palette.
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Using Cachet Adjusting Selected Colors

With Cachet, you can change colors selectively. For example, you could make a
blue shirt red.

This technique, called selective color correction, is particularly useful when
you want to match an identity color (such as a product logo) or adjust a memory
color (such as “sky blue” or “grass green”). With Cachet, you can make these
changes without changing the overall color characteristics of the image.

You can apply selective color corrections to an entire image, or you can define
masks that limit the changes to one or more regions of the image. First, select
the colors you want to change. Then, define any masks you need.

You can automatically or manually change the colors you select to match colors
in a reference image or other colors in the working image. You can even change
the selected colors to appear like PANTONE colors that you specify. Or, you

can make manual adjustments to the color cast, saturation, and lightness.

This chapter explains the tools you use for selecting and changing colors, for
creating masks, and for specifying PANTONE colors.



Using Cachet Adjusting Selected Colors The Tools:

To change selected

colors, you use the

The Selective Color palette has [REESVCHOUIFEILIE
all the tools you need to adjust

selected colors automatically
or manually. In the top half of the palette, you'll find tools for
selecting colors, automatically adjusting them to match other
colors, and limiting these changes to specific areas of the image.
The tools in the bottom half let you manually adjust the color
cast, saturation, and lightness of the selected colors.

] 1l Use the wand to
Color aints select colors.

=l Use the constraint
[ Show | Range:[ 10 tools to create
[Start Bext 5‘»\5‘3 sas | masks that limit the
changes to areas

Color Cast
you select.
Use the dropper
to automatically
adjust selected
colors to match
other colors.
Use these color
PETEENES D correction tools to
[l 7 change selected
Lightness / 0 colors manually.
[l 0]

|©\|@\|€'p|| Heset]




Using Cachet

To select colors

» Choose Selective Color from the
Image menu.

¢ Use the wand to click the
color you want to select in the
working image.

* Hold down the Shift key and
click additional colors, if

necessary.

* Hold down the Shift key or Show

button to see the selected colors.

Adjusting Selected Colors The Tools

Use the wand to select the colors you want to change. Each
time you click with the wand, Cachet momentarily highlights
pixels whose colors fall within a given range from the color you
click. To see the highlighted pixels again, you can hold down
the Show button or press the Shift key.

When you click here Cachet selects these pixels.
with the wand ...

If the first click selects some—but not all—of the pixels you
want, you can add to the selection by holding the Shift key
down and clicking again with the wand on pixels that are not
yet highlighted.
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Adjusting Selected Colors The Tools

You can adjust the range of colors by changing the setting in
the Range box in the Selective Color palette. At higher settings,
you select more colors (and Cachet highlights more pixels)
each time you click or Shift-click with the wand.

Because the same colors may appear in several parts of the
image, you may want to limit the color changes to a particular
area using masks. For example, in the picture above, you may
only want to select the red in the jacket. So you need to limit
the selection to that area. See “Masks” later in this chapter

for details.

If you don't like a selection, you can click somewhere else
in the image to select different colors. If you make several
selections, you can use the Undo command to de-select the
last color you selected.
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To match selected colors
automatically

» Select the colors you want
to change.

e Click the dropper in the
tool palette.

o Click the color you want to
match in the reference image or in
another part of the working image.

Adjusting Selected Colors The Tools

Once you have selected the colors you want to change, you can
use the dropper to pick up the color you want to match from
the reference image or another part of the working image. You
can also pick up a color from the PANTONE window. (See
“PANTONE Colors” later in this chapter.)

-

® Family Portrait-2/JPEG plerencel E
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You can use the dropper to pick up a color and apply it to the selected pixels.
If the wand is selected, the cursor automatically becomes a dropper when
you move it into a reference image window.

When you click a color with the dropper, Cachet applies that
color to the selected colors in the working image. Cachet
preserves the color variation in the selected pixels when it
applies the new color, so you get a comparable range of colors.
Cachet also shows the new color settings on the tools in the
Selective Color palette.
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Adjusting Selected Colors The Tools

You can experiment with different color matches by clicking
different colors with the dropper. When you are satisfied with
the color in the selected areas, you can record them by clicking
Start Next Selection or by selecting a different palette from the
Image menu. If you don't like any of the changes, click Reset
to cancel the color changes. After you click Reset, the colors
you selected are still selected and any masks you defined are
still active.

As long as the colors remain selected, you can adjust them
manually using the lightness, saturation, and color cast tools.

CAUTION:
When you click Start Next Selection, Cachet prepares
for your next set of corrections by recording the selective

color change, de-selecting all the pixels in the image, and

resetting all the tools in the Selective Color palette to
zero. You cannot use the Undo command to restore

the selection.
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To adjust selected colors
manually

 Select the colors you want
to change.

e Click anywhere in the color map
to adjust the color cast of the
selected areas.

® Drag the sliders to adjust the
saturation and lightness of
selected areas.

Adjusting Selected Colors The Tools

You can adjust selected colors manually using the color
correction tools in the Selective Color palette—color cast,
saturation, and lightness.

These tools work the same way as the tools in the Color
palette. They are particularly useful for making refinements
after you have matched a color automatically. Sometimes the
new color is a bit too saturated for the rest of the image or bit
too dark or too light. Without changing the selection, you can
make the adjustments you want using the color cast, saturation,

and lightness tools.

F e
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Color Cast
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Lightness \ 0
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Click anywhere in the color map to adjust
the color cast of selected areas.

Use these sliders to adjust the saturation
and lightness.
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Adjusting Selected Colors Masks:

You can limit color

changes to areas

Sometimes you may want to you select.
change a color in one part of

the image without changing it
everywhere. For example, you may want to change a red jacket
without changing other red areas of the image.

You can create masks to limit color changes to a particular area
of the image. Masks outline the area you want to change and
prevent changes from affecting the rest of the image. You can
create masks before or after you select colors with the wand.
You can also create and change masks after you change colors,
as long as you don’t click the Start Next Selection button.

Masks don'’t actually de-select pixels. Nor do they block the
wand from selecting pixels. When you click a color with the
wand, Cachet always selects all the pixels within that color
range, whether they are masked or not. But if they’re masked,
you don't see the selected pixels, and Cachet does not change
them. However, if you remove a mask, you see all the selected
pixels again. If you've changed the color of the selected pixels
and remove the mask, Cachet changes the color of any selected
pixels that were formerly masked.
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To create a mask

o Click one of the constraint tools
in the Selective Color palette.

Adjusting Selected Colors Masks

You use three constraint tools—the rectangular marquee,
the elliptical marquee, and the lasso—to outline the areas
you want to adjust using the Selective Color palette. You can
use these tools alone or in combination, outlining one or

several parts of the image at the same time.
¢ Click and drag in the image =

Is Playback Windows

to outline the area you want
to change.

* Hold down the Shift key and
outline additional areas that you
want to change.

* Hold down the Command key
and drag over an outlined area to
remove part or all of the outline.

You can outline more than one area at a time, using any
or all of the constraint tools.

As you work, you can change constraint tools and add as many
areas as you want as long as you hold down the Shift key. After
outlining an area, you can remove the outlining from part of
the area by holding down the Command key while you outline
the part you want to remove. You can also remove the outlining
from the entire area by holding down the Command key and
outlining it. To remove all the masks, click anywhere in the
image with one of the selection tools.
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Adjusting Selected Colors PANTONE Colors:

You can specify these

industry-standard colors

PANTONE colors are part of — [ERNETE TS
a proprietary system of color

matching. The system consists
of a book of color chips with identifying codes. These codes
relate the colors to inks that printers can buy ready-made or
mix to exact instructions. The system is widely used to guarantee
exact color matches for color elements like company logos.
They are also used by artists to specify colors for individual
design elements.

Cachet lets you select PANTONE colors from a special
PANTONE Simulated Color Pages window. The colors are
displayed in columns and rows of chips that are labeled with
identifying numbers. There are two sets of colors—those for
coated papers and those for uncoated papers.

You can choose a PANTONE color from a standard
PANTONE color chart and then find the corresponding
color in Cachet’s PANTONE window. Then, you can use
the Selective Color palette to apply the color to parts of
your image.

PANTONE® Color computer hard copy simulations used in this product are four-color process
simulations and may not match PANTONE-identified solid color standards. Use PANTONE Color
Reference manuals for accurate color. © Pantone, Inc., 1986, 1988.

PANTONE Color simulations are only obtainable on licensed hardware when driven by qualified
Pantone-licensed software packages. Contact Pantone, Inc. for a current list of qualified licensees.
Pantone, Inc. assumes no responsibility for color inaccuracies on non-licensed outpurt devices.
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To find a PANTONE color
by number

e Find the color you want and its
number in a standard PANTONE
color chart.

* Choose PANTONE® Colors from
the Tools menu.

® Choose Coated or Uncoated
from the pop-up menu in the
PANTONE window.

e Type the number of the color you
selected in the box at the bottom

of the window.

* Click Find.

Adjusting Selected Colors PANTONE Colors

For best results, you should work with both a standard
PANTONE color chart and the PANTONE window in
Cachet. Use the chart to find the exact color you want.
Then you can find the color by its number in Cachet’s

PANTONE window.

Use arrows to scroll a column at a time.

Choose colors for coated or uncoated
stock from this pop-up menu. \

[F5=———— PANTONE® Simulated ColohPages

Yel012U Orn021U Red032U BWOTZU PrYelU Pr Mag U
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106 U 107U 108U 109U 110U
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Type the number of a color you want to find here.

When you click Find, Cachet finds the color and outlines it
in the window. You can then apply it to selected areas of the

image with the dropper. See “To specify a PANTONE Color.”
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To find a set of close
PANTONE colors

* Choose PANTONE® Colors from
the Tools menu.

® Choose Coated or Uncoated
from the pop-up menu in the
PANTONE window.

e Click the search tool—the eye—
in the PANTONE window.

e Click the image window to make
it active and then click the color
you want to search for.

Adjusting Selected Colors PANTONE Colors

You can find the PANTONE colors that most closely match a
color in the working image or a reference image. You use the
search tool, which looks like an eye.

When you click a color in the image window with this tool,
Cachet finds a set of PANTONE colors that are close in
appearance to the color you clicked and displays them in
the PANTONE window. The closest PANTONE color

appears outlined.

EEE_ PANTONE® Simulated Color Pages

Yel012U Orn021U Red032U BWO72U PrYelU PrMagl PrCyanU PrBkU

100U 101U 102U YelU 103U 104U 105U

106U 107U 108U 109U 110U 1o 12u

[ (o) rover Uosed o
g

Click here to select the search tool. When you move the pointer over the
image, the cursor becomes an eye. You can then click the color you want
to search for.



a
PANTONE color in a
photographic image,

-you may not get the color
you want the first time.
Because Cachet applies
a range of colors to
match the range of the
selected pixels, the
resulting color may
not be exactly what
you expect.

If you're not happy with
the results, you can use
the search tool to double-
check the PANTONE
color after you apply it.
When you click with this
tool, Cachet finds the
closest PANTONE color.
So you can see how close
you are to the color you
want. You can also try
adjusting the lightness
setting, typically closer
to the zero point. You

can also experiment

with colors that are close
to the color you want to
see if they resultin a
better effect.

Using Cachet

To specify a
PANTONE Color

 Choose Selective Color from the
Image menu.

e Select the colors you want
to change.

* Choose PANTONE® Colors from
the Tools menu and find the color
you want.

e Click the dropper in the
tool palette.

e Click the PANTONE window to
make it active, and then click the
color you want.

Adjusting Selected Colors PANTONE Colors

You can apply standard PANTONE colors to selected colors in
your working image.

" & file Edit Imoge Tools Playback Windows
Eel s A O T e r——————

Select the
colors you
want to change
with the wand.

Use the dropper
to click the

PANTONE color
e T you want.

When you apply a PANTONE color, Cachet actually applies

a range of colors to preserve the color variation in the selected

pixels. So the PANTONE color is more a color guide than a
precise target. Also, some PANTONE colors may be outside
the gamut of the printing method you are using, and may
therefore be adjusted during the printing process. See “Color
Checks” in Chapter 5 for more information about out-of-
gamut colors.
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Using Cachet Displaying the Images

When you work with Cachet, you want to be able to experiment—to try out one
solution, save it, and then try several more until you get the one you want. Or,
you may simply want to keep a record of interim versions. But photographic files
are large, and saving multiple copies takes a lot of time and a lot of disk space.

10 solve this problem, Cachet gives you snapshots and scripts. Snapshots
make it easy to experiment with lots of different solutions to color problems by
temporarily saving interim solutions. Scripts make it easy to apply the best
solution to lots of similar photographs.

Of course, you'll probably want to save your final images in files when you're
through making corrections. And you may sometimes need to know how to get

rid of changes—changes that you don’t like or that you made accidentally.

This chapter shows you all the ways to save—and not save—syour work.
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Displaying the Inages Snapshots:

Use these temporary

records of your changes

When you correct a color to experiment and
image, you may go through backtrack
many steps before you get the

results you want. But you may
also want to record at least some of the steps along the way, in
case you decide that an earlier solution works better. You can
take snapshots to record these interim solutions.

A snapshot is a temporary record of the current state of the
working image. Subsequently, you can restore the snapshot
version of the image if you like it better than a later version.
You can also preview snapshots without restoring them.

Cachet automatically names snapshots “Snapshort 1,”
“Snapshot 2,” “Snapshot 3,” and so forth. But you can give
them more meaningful names. You can also delete snapshots
you no longer want.

Cachet automatically maintains one snapshot named “Last
Saved Version.” This is a snapshot of the working image when
you last used the Save or Save As command (or when you
opened the image if you haven't saved it since).

CAUTION:

Snapshots are temporary. If you save changes with the

Save or Save As commands, close the image without

saving changes, or use the Revert command to restore
the original image, all the snapshots are lost.
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To take a snapshot

® Choose Take Snapshot from the
Playback menu.

e If you want, type a name for
the snapshot.

e Click Snap.

Saving Your Work Snapshots

You can take a snapshot of the working image at any stage in
your color correction. You can take as many snapshots as your
Macintosh memory allows. (Fortunately, snapshots take up
very little memory, especially compared to image files.)

When you take a snapshot, a dialog box prompts you for the
name of the snapshot. You can type a descriptive name, or you
can let Cachet automatically assign a snapshot number.

—— htornme |

Last Saved Dersion 4r)
]
What is this Snapshot’s name?

2
Cachet automatically numbers snapshots. You can give

them more meaningful names.

When you click Snap, Cachet temporarily records the current
state of the image.
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To preview snapshots

* Choose Restore Snapshot from
the Playback menu.

e Select the snapshot you want
to preview from the list in the

dialog box.

e Click Preview.

Saving Your Work Snapshots

You can preview a snapshot before you decide to restore it as
the working image. You select the snapshot from the list in the

Restore Snapshot dialog box.

Select the snapshot you want to preview.

N .

I S ) iz is s snapshot
of the working
image when you

Last Saved Uersion 0| >
Snapshot 1
Rename... last saved it.

N\
Click here to pre-

view the selected
snapshot.

i

Restore

<l

When you click Preview, Cachet temporerily displays it as the
working image. Cachet displays the tool palette you were using
when you took the snapshot, and the palette reflects the settings
for the snapshot. The dialog box remains open. If it blocks
your view of the working image, you can move the dialog box
by dragging the title bar at the top.

If you don't like the snapshot, you can select a different snapshot
and click Preview again.

If you like it, you can click Restore to restore it.
If you don’t want to restore any of the snapshots, you can click

Cancel. Cachet then displays the image as it was when you
chose the Restore Snapshot command.
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To restore a snapshot

* Choose Restore Snapshot from
the Playback menu.

* Select the snapshot you want
to restore from the list in the

dialog box.

e Click Restore.

Saving Your Work

If you decide to “go back” to one of your snapshots, you can
restore it as the working image. You select the snapshot you
want to restore from a dialog box that lists all the snapshots
you have taken.

[E==—=—=——=—=="Restore snapshot =

Last Saved Version <)
Snapshot 1

Rename...

Delete...

Cancel

=

When you click Restore, Cachet adjusts the working
image to match the appearance of the snapshot.

If you were working with a different tool palette when you
took the snapshot, Cachert displays that tool palette and the
settings you used to correct the image.

After you restore a snapshot, you can continue making changes,
or you can save the snapshot solution in a script or in a file.
See “To create a script” in the section on “Scripts” and “To save
changes” in the section on “Files,” both later in this chapter.
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To rename a snapshot When you take snapshots, you may find that it’s faster and
more convenient to let Cachet label them by number rather

* Choose Restore Snapshot from than type a descriptive name each time. However, if you take

the Playback menu. a lot of snapshots, the numbers may become less meaningful.

You can rename these snapshots to identify them more clearly.

* Select the snapshot you want
to rename from the list in the When you click Rename, a new dialog box prompts you for
dialog box. the name.

* Click Rename. Rename Snapshot

0ld Name: Snapshot 2
New Name: |Final Snapshof |

* Type the new name in the new
dialog box, and then click OK.

([ cancet | [ ok ||

* Click Cancel to close the Restore
Snapshot dialog box.
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To delete a snapshot

e Choose Restore Snapshot from
the Playback menu.

e Select the snapshot you want
to delete from the list in the
dialog box.

 Click Delete.

e Click Cancel to close the Restore
Snapshot dialog box.

Saving Your Work Snapshots

You can delete snapshots as you work to get rid of any that
you no longer need. You can select the snapshots you want to
delete from the Restore Snapshot dialog box. You can preview
them before you delete them.

When you click Delete, a new dialog box displays the name of
the snapshot and asks you to confirm that you want to delete
it. If you click OK, the snapshot is permanently removed
from memory, and its name is removed from the snapshot
dialog boxes.
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Saving Your Work Scripts:

Use thCSC permanent

records of changes to

As you work with an image, make the same corrections

you can capture all the changes [RGRUTTSSTUERED
you make and save them as a

permanent record called a
script. You can then use the script in several ways:

* For groups of images that all have the same problems, you

can correct one of the images, save the script, and then apply
the script to the rest of the images instead of correcting each

one individually.

* Even though Cachert uses a low-resolution version of the
working image for your interactive session, it still needs to
process the complete image file whenever you print, save,

or create color separations. So, when you need to work with
large image files, you can work more quickly if you correct

an image scanned at low resolution, save the corrections in a
script, and then apply the script to the same image scanned at
a higher resolution.

* You can also use scripts as a quick way to save different
versions of the image as you work. Unlike snapshots, which are
temporary, scripts are permanent and can be used to recreate

a series of color corrections at any time. Interim scripts are
particularly valuable if your system fails while you are working.

Scripts are saved as permanent files on your disk and are always
available until you remove them from the disk.
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To create a script
e Correct your image.

* Before you choose Save or
Save As from the File menu,
choose Save Script from the
Playback menu.

* Type a name for the script in the
dialog box.

e Click Save.

Saving Your Work Seripts

As you work with an image, Cacher records all of your
operations. You can save this record as a script at any time
during color correction. The Save Script dialog box prompts
you for a name for the script.

1 Scripts ¥

itd = Station 4

Eject

Desktop

(Concat )

2|

Save Script File As:
[seript 1] |

When you click Save, Cachet saves the script file on your

disk. You can rename or remove these files as you would any
standard Macintosh file. You may want to create a folder for all
of your scripts.

CAUTION:
If you plan to create a script, be sure to choose Save Script
before you choose Save or Save As. Choosing Save or

Save As applies your corrections to the data in the image
file and deletes Cachet’s internal record of your changes.
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To apply a script

* Open the image you want
to change.

* Choose Apply Script from the
Playback menu.

e Select the script you want from
the dialog box.

e Click Open.

Saving Your Work Seripts

You can apply a script to any working image. When you
choose Apply Script, Cachet displays the standard directory
dialog box. You can use this dialog box to select the script.

3 Scripts ¥
o Station 4
O Script 1 -
D script 2
Desktop

When you open the script, Cachet performs the same sequence
of operations that you originally performed when you created
the script. Cachet shows the progress of this operation.

CAUTION:

When you apply a script, the operations recorded in the
script are performed on the most recently saved version

of the working image. Any changes you make but do not
save before applying the script will be lost.
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Saving Your Work Scripts

Once the script is applied, you can make additional changes or
save the image with the Save or Save As command. If you don't
like the results, you can choose Undo immediately after you
apply a script to restore the original image. You can also use
the Revert command to restore the original image after you
apply a script. You may have to adjust the image window after
you use the Revert command.

If your script includes changes made with the Orientation
palette or with the constraint tools in the Selective Color
palette, Cachet asks if you want to apply these changes when
you apply the script. Cachet applies constrained selective color
changes to the same regions of the working image as were
outlined with constraint tools in the image with which you
created the script. Unless the two images are more or less
identical, the constrained selective color changes are probably
not appropriate.

There are Orientation or Selection
operations in this Script. Do you want to
apply those changes?

Orientation or Selection Changes
O Apply all changes.

Omit Orientation and Selection changes.

/ [ cancel ] [ npply ||
-

Click here if the selective color and orientation
changes in the script are not appropriate for the
image you are correcting.
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Saving Your Work Files:

When you save changes

in a file, the changes

In Cachert, the best time to save [JEIHUSIHELT

images in files is usually when

you're through making color
corrections. For large files, saving can take a long time. Saving
also permanently changes the image file. So it’s better to use
snapshots and scripts to save as you work, and then save the
image in a file when you're sure you've got it the way you want it.

As in most Macintosh applications, there are two ways to save
images in files. You can save your changes, replacing the original
image. Or you can save the image with a different name, leaving
the original image file intact.

You can save images you've corrected with Cachet in any of the
following file formats: TIFF-RGB, PICT, Adobe Photoshop,
or Raw-RGB. See “Files and File Formats” in the section on
“The Software” in Chapter 6 for explanations of these formats.

This section does not explain how to generate color separations
using the Save Separations command on the File menu. You'll
find this information in Chapter 5 under “Color Separations.”




Using Cachet

To save changes

® Choose Save from the File menu.

Saving Your Work Files

You can save changes you make to an image, permanently
replacing the original image with the new image data. When
you save changes, Cachet saves the new image in a file with the
Cachet icon. This icon shows the format of the file. The formart
is the same as the format you used to open the file. Cacher also
resets all the color settings for the Cachet tools to zero.

CAUTION

You cannot restore the original image after you choose
Save. If you want to save the new image without
destroying the original, use the Save As command (see
next page). If you want to save interim versions of the
image as you work, see the section on “Snapshots” in

this chapter. If you want to save color settings without

changing the original image, see the section on “Scripts”

in this chapter.
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To save the working
image with a
different name

* Choose Save As from the
File menu.

e Type a new name for the file.

e Select a file format from the
Format pop-up menu.

» Click Save.

Saving Your Work Files

You can save the working image with a different name if you
want to save the changes you've made and preserve the original
image. When you choose Save As, Cachet prompts you for the
name, location, and format of the new file:

< User Images ¥

i3 Atter a Ride i}_ — Station 4
01 House

£ New yp
3 Gn a Picnic

1 On the Dok
£3 Puddie Stomping |m_
0 Sunny Picnic — .
1 Pagetable Baskel =] [ cancel )

Save Document as:
|l|.ln;king Image |

/{rmat: TIFF
/

Type the new name here.

Click here to select a new format
for the copy, if you want.

You can save the file in TIFF-RGB, PICT, Adobe Photoshop,
or Raw-RGB format. See “Files and File Formats” in the
section on “The Software” in Chapter 6 for explanations of
these formats.

After Cachet saves the new file, it becomes the new
working image.
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To save an image in
compressed format

» Choose Expori from the File menu.

e Select a plug-in module from the
Export using list.

* Choose No Corrections from the
Correct for Printer list unless you
want to save device information

for one of the listed printers.

* Choose the sharpening level
you want, or choose None for
no sharpening.
e Click Export.

e Select options in the dialog box.

* Click OK.

Saving Your Work Files

You can compress and de-compress image files with plug-in
modules compatible with Adobe Photoshop. Because color
image files are so large, you may want to compress your images
when you are not working on them.

When you choose Export from the File menu, Cachet displays
a dialog box so you can choose a plug-in module, and set other
export options.

Choose a plug-in
Export using:[ Storm JPEG Compress... .
’ d z j/ module for file
Correct for Printer:| No Corrections ] compression
sharpening:[ None __— | 9 from this list.
[ cencel ] | Enport || Usually, you'll
choose No
R Corrections here.

Choose the sharpening level you want.

Correct for Printer When you are saving an image in compressed
format, you generally don’t need to save device information, so
you can usually leave Correct for Printer set to No Corrections.
However, if you plan to open the compressed file in another
image editing application and then print the file from that
application on a three-component (RGB or CMY) device,

you can save device-specific printing information in your
compressed image file.

Sharpening You can sharpen your image before saving it.
Sharpening is a process of image enhancement that results in a
“crisper” looking image. You can choose None, Low, Medium,
High, or Maximum. If you re-open the compressed file in
Cachet or another image editing application, you will see

the results of sharpening. (For an example of the effects of
sharpening, see the “Sharpening” sidebar on page 5.16.)
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Saving Your Work Files

You may also use the Correct for Printer and Sharpening menus
if you are printing on a printer that is accessed through a plug-
in module instead of the Macintosh Chooser. (For information
about printing through plug-in modules, see “To print using a
plug-in module” in the section on “The Early Proof” in
Chapter 5.)

After you click Export, the plug-in module you selected displays
its own dialog box with any options or settings you need to
select. Refer to the documentation that came with the plug-in
module for information about these options.

For more information, refer to the sidebar on plug-in modules
on page 1.6, or refer to “Plug-In Modules” in the section on

“The Software” in Chapter 6.
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Saving Your Work Oo Ps!

When you make changes

you don’t want to save,

Color correction is an iterative [JEEIEESTHETI
process. Cachet streamlines the

process, but you're still bound
to make some changes that you later decide aren’t quite right.

Sometimes it’s easy to see right away that you didn’t get the
result you wanted from a change. But sometimes, you go
through several steps before you realize you need to back up.
So Cachet gives you three ways to recover from wrong choices
or accidents:

* You can undo the last operation you performed.

* You can reset some or all of the tools in the palette you're
currently working with.

* You can get rid of all the operations you've performed since
you last saved the image, reverting to the original.

Of course, you can also use snapshots to save and restore
interim versions of the image. See “Snapshots” in this chapter.
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To undo the last change

® Choose Undo from the Edit menu.

Saving Your Work QOops!

You can undo many of the operations in Cachet if you choose
the Undo command immediately after you perform the
operation. For example, if you are selecting several colors for
selective color correction and you accidentally select the wrong
one, you can use the Undo command to undo the last selection,
leaving the rest of the selection intact. You can also undo the
effects of restoring snapshots and applying scripts.

When you choose Undo, the command name changes to Redo.

If you then choose Redo, Cachet performs the operation you
just undid.

CAUTION:

You cannot undo any of the commands in the File menu.
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To reset the settings in the
current tool palette

¢ To reset an individual tool, hold
down the Command key and click
the tool.

* To reset all the tools, click the
Reset button in the tool palette.

Saving Your Work Oops!

As you work with a tool palette, you may change the settings
for one or more of the tools in that palette. You can reset an
individual tool to remove all the changes you've made with
that tool. Or you can reset the settings for all the tools.

When you reset all the tools, Cachet generally displays the
image as it appeared when you most recently opened the tool
palette. If you save the image and then make additional changes
without switching to another palette, the Reset button displays
the image as it appeared when you last saved it.



Using Cachet

To revert to a previous
version

* Choose Revert from the
File menu.

Saving Your Work Oops!

You can always restore the last version of the image that you
saved, regardless of how many operations you have performed
or which tool palettes you have used. When you choose the
Revert command, Cachet asks you to confirm that you want
to discard all the changes you've made since you last saved
the image.

If you don’t remember what the last version you saved looks
like, you can preview it by restoring the snapshot named
“Last Saved Version.” For more information, see “To preview
snapshots” earlier in this chapter.

CAUTION:

You cannot undo l'hf.' RE\-"EI'[' command.




. Using Cacher Printing

X i TN 53 . Color Checks
. 510 The Early Proof

- 518  Color Separations.

S W
1




Using Cachet Printing

With Cachet, you can print color images directly on a color printer. Or you can

prepare color-separation files that you can use to generate color separation films
on an imagesettex

In both cases, Cachet uses EfiColor device profiles to achieve faithful color
reproduction. A device profile is a collection of information about a printer or
printing method. It contains all the information that Cachet needs to reproduce
a color image faithfully using that printer or printing method. As long as you
have an EfiColor device profile for the printer you want, you can print from

Cachet and know that the colors in the printout are a faithful rendering of the
true colors in your image.

Of course, because of the limits of printing devices, not every picture will print
perfectly on every printer. So Cachet has two tools that you can use to check for

color reproduction problems before you print—a gamut alarm and a color
meter.

This chapter explains how to get an “early proof” on a color printer and how to

make color separations for professional color reproduction. It also explains how
to use the gamut alarm and the color meter.
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Printing Color Checks:

Before you print, you can

check for out-of-gamut

Every printer or printing colors and measure color
method has a gamut—the values
range of colors that it is capable

of reproducing. Each image
also has a gamut—the range of colors that make up the image.
Sometimes, the gamut of the printer and the gamut of the
image do not match. Your image may contain out-of-gamut
colors—that is, colors that your printer cannot reproduce.

Whenever you print or create color separations, Cachet
automatically adjusts the gamut of your image to fit within the
gamut of the printing method you choose. However, if you
want to adjust out-of-gamut colors manually, you can use
Cachet’s gamut alarm to determine which colors are out of the
gamut of your reproduction method.

You may also want to check the values of individual colors
with Cachet’s color meter before you print. You can measure
the RGB, CIELAB, and CMYK values of any color in your
image. The color meter gives you a numerical reading of the
colors in your image.
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To check for out-of-gamut
colors

* Choose Gamut Alarm from the
Tools menu.

* Choose a printer or printing
method from the Target Printer
pop-up menu in the Gamut Alarm
window.

* Click Check.

Printing Color Checks

When you get ready to print, you can use Cachet’s gamut
alarm to check your image for colors that your printing
method cannot reproduce.

HnfE When you click
Target Printer:| SWOP-Coated Check, Cachet
analyzes the
colors in your
image and
- k compares them
Click here for a pop-up menu of printers. You select to the capa-
the printing method you plan to use for your final bilities of your
reproduction. printer.

You always choose the printing method that you plan to use
for your final reproduction. When Cachet has finished
analyzing the image, it briefly highlights all the areas that are
out of the gamut of the printing method you chose. If
necessary, you can then adjust the colors (typically using the
saturation and lightness tools), and then click Check again to
re-check the image.
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To show out-of-gamut After you have checked the image with the Check button, you

colors can view the problem colors again with the Show button in the
Gamut Alarm window. Cachet highlights the out-of-gamut

* Click and hold the Show button  areas of the image as long as you hold down the Show button.

in the Gamut Alarm window.

sensitivity:[ 9 |
Tarn up the serusitivity 4s fied mors of [or ]

the culors eutaide e priters garmt =T

==
Targel Printer:

The colors in the highlighted areas
are out of gamut for your printer.

See the sidebar on the next page for guidelines on adjusting
out-of-gamut colors
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What to adjust when colors
are out of gamut

When colors are out of gamut, you
don't have to do anything. Cachet auto-
matically adjusts the gamut of your
image to the gamut of your printer or
printing method. Nevertheless, you may
want to make your own adjustments.
Here are some guidelines.

« |f you have a few out-of-gamut colors
in the background of your image, let
Cachet make the adjustments
automatically.

= If your visual center of attention is out
of gamut, you can get involved.
However, if you adjust the image so
there are no out-of-gamut colors, your
image may appear too pastel.

Printing

Therefore, the best results are usually
achieved with a moderate amount of
out-of-gamut colors.

* Most out-of-gamut problems are
saturation problems. If a lot of the
colors across the entire image are out
of gamut, adjust the overall saturation.

= If the out-of-gamut colors are
localized—maybe they all appear in the
reds-use selective color correction.
You don't want to reduce the overall
saturation just to compensate for one

part of the image that is oversaturated.

(However, if most of the out-of-gamut
colors are skin tones, try to solve the
problem by correcting the overall
saturation—skin tones are difficult to
correct selectively.)

Color Checks

= Before drastically reducing the
saturation, though, try making small
lightness adjustments. Because printer
gamuts are widest around the
midtones, a small increase in the
lightness of a shadow color or a small
decrease in the lightness of a highlight
color may put them in the gamut
without sacrificing saturation. Big
changes in lightness, however, are not
advisable since they might cause
significant loss of detail.
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To adjust the sensitivity of
the gamut alarm

» Click the up arrow to increase
the Sensitivity setting in the Gamut
Alarm window and find more out-
of-gamut colors.

» Click the down arrow to
decrease the Sensitivity setting
and find fewer out-of-gamut
colors.

Printing Color Checks

When you check for out-of-gamut colors, you may find that
the gamut alarm s either too sensitive or not sensitive enough
for your purposes. In other words, you may want to be warned
about more (or fewer) out-of-gamut colors than the gamut

alarm highlights automarically.

You can adjust the sensitivity of the gamut alarm to get just as
much warning as you want. You use the sensitivity setting in
the Gamut Alarm window. If you want to be warned about a//
out-of-gamut colors, use the highest setting. On the other
hand, if you want to be warned only on colors that are
extremely out-of-gamut, you can use a lower setting.

Target Printer:| SWOP-Coated v |

sensitivity:[ 9 _|[3]

Turn up-the sensitivity to find more of
the rs outside the printer's gamut.

>

This controls how many colors Cachet highlights when
you check for out-of-gamut colors.

...than it does with the Sensitivity
setto6.

The gamut alarm highlights more
colors with the Sensitivity setto 9 ...
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To measure color values

* Choose Color Meter from the
Tools menu.

» Choose a mode from the pop-up
menu in the Color Meter window.

» If you are checking CMYK values,
choose the target printer and GCR
level.

* Click the color you want to
measure in the image. Or hold
down the mouse button to measure
values as you drag.

Printing Color Checks

You can measure colors in an image with Cachet’s color
meter. This tool gives you a numeric reading of the color
values, as well as showing visually their position within a
given color space.

This swatch shows
the color under the
color scope.

The color map
gives you a picture
of the position of
the color in the
CIELAB color
space.

The color scope Click here to choose
measures values RGB, CIELAB, or
continuously when CMYK values. If you
you hold down the choose CMYK values,

mouse button and you must also select a

move the cursor over  target printer, and you

the image. can also choose a
GCR level.

When you choose Color Meter from the Tools menu,

the color scope is automatically selected. When you move the
pointer into the image area, the cursor becomes a scope. When
you click, Cachet reads the values of the color under the scope.
It displays the color as a swatch in the Color Meter window.

It also displays the position of the color on a color map. You
can drag to see the color values for different color areas across
the image.
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Printing Color Checks

The meter shows color values in three color spaces: RGB,
CIELAB, and CMYK (for a specific reproduction method). It
also shows you the position of the color in the CIELAB color
space with a color map. The number on the map represents
the lightness of the color, where 0 is black and 100 is white.
The position of the number indicates the color’s position in
this color space.
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Printing The Early Proof:

You can use color

printers for quick,

With Cachet, you can use a inexpensive color proofs
color printer to get a quick

printout of your image. You
can print directly to a variety of color printers. For a complete

list, refer to the EfiColor Profiles Guide.

You can use the Print command on the File menu to print an
image on the printer you have designated with the Chooser.
However, a few color printers are only available through plug-
in modules. If your printer is one of these, you need to use the
Export command on the File menu when you're ready to print.

Whichever way you print, you can specify the appropriate
EfiColor device profile, the page and image size, the
orientation, and other printing options, depending on the
printer you are using. This section gives the details.
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How device profiles assure
consistent color

Different kinds of color printers produce
color in different ways.

Some printers, such as the Kodak
XL7700, the Fiery/Canon CLC1, and the
Fiery/Canon CLC500, produce
continuous tone images. Others, such
as the QMS Color Script 100 , are
halftone printers.

Printers also differ in the number of
colorants they use. The Kodak XL7700
uses just three: cyan, magenta, and
yellow. The Fiery/Canon CLC1,
Fiery/Canon CLC500, and the QMS
ColorScript are CMYK printers. On the
Macintosh, the HP PaintWriter can be
accessed only as an RGB device.

To get consistent results on such
diverse printers, Cachet naturally has to
make a lot of adjustments to the color
values in an image. To make these
adjustments, Cachet uses EfiColor
device profiles that characterize
particular printers and printing
methods.

Printing

* When you use the gamut alarm to
check for out-of-gamut colors, Cachet
uses a device profile to determine
which colors your printer will not be
able to reproduce.

* When you measure CMYK values with
the color meter, Cachet uses a device
profile to determine the CMYK values
that are necessary to reproduce the
color you measure on the printer you
specify.

* When you print directly to a printer,
Cachet uses the device profile for that
printer to map the gamut of your image
to the gamut of the printer and then
convert the RGB values in the image file
to the appropriate CMY, CMYK or RGB
values for the printer you are using.

* When you make color separations in
Cachet, and then import the files into a
page layout program for printing,
Cachet uses a device profile to make
color separations that will produce the
most faithful reproduction of your color
image with the printer or printing
method you plan to use.

The Early Proof

Cachet comes with EfiColor device
profiles for a variety of color printers, as
well as several offset printing
configurations. The Cachet Installer
installs these device profiles
automatically when you install Cachet.
However, you can choose to install only
those profiles you need for the printers
and printing methods you plan to
use—and save some disk space.

If Cachet doesn’t have a device profile
for the printer or printing methods
you're using, you can call the technical
support team at EFl for advice. Refer
to the technical support information
included with Cachet.
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To set up the printed page

* Choose Page Setup from the File
ment.

* Choose the standard page setup
options that apply to your printer.

* Click OK again to close the Page
Setup dialog box.

Printing The Early Proof

You can specify the paper size for your printout. You can also
specify the orientation of the image on the page—horizontal
or vertical—as well as a percent reduction or enlargement.
Your printer may have a variety of other options for such
things as printer effects and image inversion. These options all
appear in the Page Setup dialog box and should be described in
the documentation that comes with your printer.
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To print directly from
Cachet

* Make sure you have designated
the printer you want with the
Chooser.

* Choose Print from the File menu.

* Specify the number of copies and
the type of paper feed.

* Choose your printer in the Target
Printer pop-up menu.

* Click Size to change the height,
width, or resolution of the image
before printing.

* Click the Halftone button to
modify the halftone setup if your
printer supports halftoning.

* Choose the GCR level you want
from the GCR pop-up menu.

* Choose the sharpening option
you want from the Sharpening pop-

up menu.

* Click OK.

Printing The Early Proof

When you print on a printer you have selected with the
Chooser, Cachet uses the Print dialog box for the printer you
selected. You must also specify the target printer in the Print
dialog box. In addition, you can set GCR and sharpening
levels, and for PostScript printers you can change the size and
control the halftone setup.

Selecting a target printer You must specify the target printer. A
pop-up menu lists all the printers you can use with Cachet.
When you choose one of these printers and click OK, Cachet
maps the gamut of your image to the gamut of the printer and
produces the data necessary to print the image.

Laserlriter “Canon Fiery” 71
Copies:@ Pages: @ All O From: :l To: |:l
Cover Page: @ No O First Page O Last Page

Paper Source: @ Paper Cassette (O Manual Feed

Print: (O Black & White @ Color/Grayscale

Destination: @ Printer O PostScript® File

Target Printer:| Fiery/Canon CLC500 v] (Halftone...]

Always specify the target printer when you print. Cachet then converts the
image data to the appropriate CMYK, CMY, or RGB data for your printer.

CAUTION
Some printers may also offer other useful options. You
can refer to the documentation that comes with your

printer for explanations of these options. Using these

printer-specific options, however, may affect the

appearance or quality oI your printcd inmge.
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Printing The Early Proof

Changing the image size and resolution If you're printing on a
PostScript printer, you can click the Size button to change the
image size and resolution before printing. When you click the
Size button, a new dialog box appears. You can use this box to
specify the height or width you want. These changes affect
only the printed image, not the image file itself.

/' You can specify
Image size... . . .
3 . 3 fllmenSIOns in
Width:  2.68 [Cinches ¥ ’”c”?sf
Helght: 129 COnamSIars;
picas, or points.
Resolution: |300.00 | [Cpinels/inch v}l .
You can specify
File Size (Kb); 1,266 1,266 805 1 537 2 <
resolution in
erve(file Size pixels per inch or
pixels per
“ centimeter.

Specify the height, width, or resolution that you want.
Cachet calculates whichever values you don't enter.

You need to enter the height, width, or resolution you want.
Cachet calculates the remaining values, preserving the aspect
ratio of your image as it appears on the screen. If you need to
change the aspect ratio to meet page layout requirements, you
can either:

e crop the image using Cachet’s cropping tool (see “To crop an
g pping P
image” in the “Orientation” section of Chapter 1); or

* make color separations, import them into your page layout
document, and adjust the size there (see “Color Separations”
later in this chapter).
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Printing The Early Proof

Changing the halftone setup PostScript devices let you modify
the halftone setup, including the line frequency, screen angles,
and dot shape. When you print to such a device, you can click
the Halftone button in the Print dialog box to change the

halftone setup. When you click the Halftone button, Cachet
displays the following dialog box:

Halftone Screens for SWOP_CORTED

[ 3 M: ¥: K:

Frequenew: [ 15p.92] [ (50.92] [ 1s0.92] [ 1sp.92] Linessinen
fAngle: | sz2.5p| | s2.5p) | 250 [ 112.5p] Degrees

- It Shapa 1

{Dnnund QO Elliptical QO Custom... |

F Use ‘Native’ Printer Screens

!

Uncheck this box to change line frequency, screen angles, and dot shape.

Halftone Screens for swop_coated / Cfn'l'-'k here to
save your
C: M: y: K:
i halftone setup.
Frequency: | 150.92| | 150.92| | 150.92| [ 150.92 Lines/inch - P
|~ Click here to
Angle: [ 82.50] [ s2.50| [ 7.50] [ 112.50] Degrees (Coemaiy) r————
Dot Shape setup you have
I_@ Round O Ellipllcul/e Custom... prevfous:‘y
DUWBHS . \ saved.
Click here to use

Cachet’s default

Click here if you want to enter PostScript code to customize the dot shape.
halftone setup.

Sharpening the image Whenever you print on a color printer,
you have the option of sharpening your image first.
Sharpening often produces a “crisper” looking printout. You
can choose among the following sharpening levels: None, Low,
Medium, High, or Maximum. (See the sidebar on the next
page for more information.)
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Sharpening your image
at output time

Whenever you print on a color printer,
generate color separations, or export
an image file in compressed format, you
have the option of sharpening your
image first.

Sharpening is a process of image
enhancement that results in a “crisper”
looking image. When you sharpen an
image, Cachet detects areas in the
image where obvious changes in color
occur and automatically increases the
contrast or focus along these edges,
giving the image a sharper overall
appearance.

You can choose among the following
sharpening levels: None, Low, Medium,
High, or Maximum.

High sharpening

Maximum sharpening
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To print using a plug-in
module

* Choose Export from the File
menu.

* Select the appropriate plug-in
module from the Export using

pop-up menu.

= Choose your printer from the
Correct for Printer pop-up menu.

* Choose the sharpening level
you want from the Sharpening
pop-up menu.
* Click Export.

= Select options in the dialog box.

* Click OK.

Printing The Early Proof

A few color printers are not accessible through the Macintosh
Chooser, but rather through a plug-in module that comes with
the printer. For more information on plug-in modules, refer to
“Plug-in Modules” in the section on “The Software” in
Chapter 6.

When you print using a plug-in module, you must choose the
appropriate plug-in module and specify the target printer in
the Export dialog box. In addition, you can sharpen your
image before printing.

Selecting a target printer You must specify the target printer. A
pop-up menu lists all the printers you can use with Cachet.
When you choose one of these printers and click OK, Cachet
maps the gamut of your image to the gamut of the printer and
produces the data necessary to print the image.

Choose the plug-in
Export using:| Storm JPEG Compress... v']/—|/ miidile her; g

Correct for Printer:[ Kodak HL?700(Chooser) +}——

[~ Specify the printer
you're using.

([ cancet ] [ Emport ||

7
Choose a sharpening level if you want.

CAUTION
Some plug-in modules may also offer other useful
options. You can refer to the documentation that comes

with your printer for explanations of these options.

Using these printer-specific options, however, may affect

the appearance or quality of your printed image.
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Cachet separates the

images—then your page
Most full-color printing layout program prints

processes produce color images RUTEREEES

by first separating them into

four monochrome images
called color separations. These four images are then printed
in four different colors to produce the full-color image. The

four colors—or printing primaries—are Cyan, Magenta, Yellow,

and black (CMYK).

Color separation is typically an expensive, time-consuming
process that requires a lot of expertise. But with Cachet, you
don’t need to do all of the calibrating and fine-tuning that’s
required by the traditional color separation process. Cachet
uses the EfiColor device profiles to calculate the color
separation values appropriate to the printing process you are
using. As with color printers, Cachet converts the RGB values
that make up your image to CMYK values that will reproduce
the image on the proofing system you choose, faithfully
rendering the true colors in your image.

When you've made all your color corrections and you're ready
to make color separations, you follow three steps:
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Step 1. Create color separations in Cachet.

Cachet produces color separation files that will faithfully
reproduce your image, using the printing method you select.
You need to create color separation files for each printer or
reproduction method you plan to use. In other words, if you
produce early proofs on a color printer but still plan to use a
professional proofing system before going to press, you'll need
to generate two sets of color separation files—one for the color
printer, and one for the professional proofing system.

Step 2. Import the color-separation files into a page layout
program.

You can place the color-separation files on pages in most major
page layout programs. You can crop them and change their size
without affecting the color reproduction.

Step 3. Use the page layout program to print the publication.

Finally, you print the publication on a color printer, or
generate color separation films on an imagesetter. Whichever
way you print, your page layout program uses the color data
created by Cachet to reproduce your color images faithfully.
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To create color
separations

To make color separations, you create a file or set of files that
you can use to print composite proofs on a color printer or
produce color separation films on an imagesetter. You create
these color separation files with the Save Separations
command on the File menu.

= Choose Save Separations from
the File menu.

* Choose a printer or printing When you choose Save Separations, Cachet displays a dialog
process from the Target Printer
list,

box you use to set options for your color separation files.

Choose whether to save your
separations in EPS, TIFF-CMYK,

Choose the reproduction method you
will be using—generally a printing

= Click the file format you want in
the File Format box.

* Choose the GCR level you want if
your printer or printing process
supports GCR.

e Choose the Sharpening level you
want.

* Choose the file options you want
from those displayed in the bottom

half of the dialog box.

* Click OK.

method such as SWOP.

Raw-CMYK, or Raw-RGB format.
\

R

File Format

EPS
QO TIFF - CMYK
O Raw - CMYK
QO Raw - RGB

— File Format —
) Normal
® DCS (5 files)

sharvening:_Fope”__7)
— Encapsulated PostScript File Options

Printer options \\
Target Printer:| SWOP-Coated

GCR Level:

High >

— Data Format —

O ASCIHI tent
@ Binary

/— DCS Image Data

() Only in sub-fil
@ Also in main file

7

2

/
/[ cancel | [[ ok |
I 4

~

Choose the GCR level you want (if
your printer supports GCR).

Choose the sharpening level you
want.
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Printing Color Separations

These options change depending on the File Format you
choose and are explained on the next two pages. You can save
separations in four different file formats, and the options
shown in the bottom half of the Save Separations dialog box
vary depending on which file format you choose. The four file
formats are:

* EPS/DCS

* TIFF-CMYK
e Raw-CMYK
* Raw-RGB

Most printers do not support all of these formats. Any that are
not available appear grayed out in the dialog box. If you're not
sure which format to use, refer to the sidebar on color
separation file formats. Whichever file format you select, you
can set additional options in the bottom half of the dialog box.
Refer to the notes below.

When you click OK, Cachet prompts you to enter a name for.
the color separation files:

= Hard Disk 2

O House

0O New UP

D 0On a Picnic

0 On the Dock

O Puddle Stomping
0 Sunny Picnic

Eject

Desktop

Please name separations file: Cancel

;@

Cachet adds the suffix .sep to the file name, but you
can change it if you want.

R
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EPS/DCS File Options If you are saving separations in EPS
format, the bottom half of the dialog box lets you specify the
File Format, Data Format, Preview Picture, and DCS Image
Data options. In addition, you can use the Size button to resize
the image, and you can use the Halftone button to change the

halftone setup.
If you need to see
color on the screen,
For many purposes, a this option gives you a
Normal format produces\  black-and-white This option displays a  preview image with
a single file with four image is sufficient. blank frame. 256 colors.
separations. i L //
. — File Format Printer options
7
il @ EPS arget Printer:| SIWOP-Coated -]

files—four separation
files (sub-files) and a

O TIFF - CMYK

control file (main file). [Nome ___~])

Use ASCII if you're work- N

- . File t—

ing with PageMaker 4.0 i

or 3.02 Color Extension. Des (5 files)

Binary is more compact ||\ )

and faster to print. \E Data Format —

This option saves space @ Binary

if you don’t need to print Z

color composite proofs /

on a color printer. .
If you choose this Click here to change Click here to change
option, you can use the line frequency, the image size and
the DCS files to screen angles, and resolution.
produce color dot shape.
separations and to
print color composite

proofs on a color
printer.
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Printing Color Separations

* File Format. You can choose Normal for standard EPS
format, or DCS if you want to generate Desktop Color
Separation files.

* Data Format. You also specify a data format. You should use
the binary format unless your page layout program or other

application requires ASCII data.

* Preview Picture. You can specify how you want the image to
appear in your page layout application: as a blank frame, a
black-and-white image, or a color image.

* DCS Image Data. If you choose the DCS file format, you
must also specify whether you want the color separation data
to appear only in the four separation files or also in the control

file.




Using Cachet

Printing Color Separations

* Size. Click the Size button to change the image size and
resolution before generating color separations. Cachet displays
a dialog box you can use to specify the height or width you
want. These changes affect only the printed image, not the
image file itself.

L~ You can specify

[ Preserve File Size

7
Specify the height, width, or resolution that you want.

Image size... - . .
Curnls  Naig Unit: ff.fmensmns in
Width:  2.68 [Cinches ] inches,
Height:  1.79 ctﬂ.n!?merers,'
picas, or points.
Resolution: [300.00 | [Cpinels/inch ~] |f
s You can specify
File Size (Kb);~" 1,266 1,266 805 1 537

resolution in
pixels perinch
or pixels per
centimeter.

You need to enter the height, width, or resolution you want.
Cachet calculates the remaining values, preserving the aspect
ratio of your image.
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Printing Color Separations

* Halftone. Click the Halftone button to change the halftone
setup—including the line frequency, screen angles, and dot
shape—if your printer or printing method supports
modifications of the halftone setup. Cachet displays the
following dialog box:

/" Click here to save
Halftone Screens for swop_coated ha/ftane setup
- your .
C: M: v K: - >
Frequency: [ 150.92] [ 150.92] [ 150.92] [ 150.92] Lines/inch (_sove.> ] ,f"?’;fohe’e t;:l:;’ag a
([ Load.” ) ne se you
Angle: [ 82.50] [ s2.50] [ 7.50] [ 112.50] Degrees e have previously
Dot Shape saved.
|_© iy Gtiptient i s Click here to use
[J use ‘Native’ Printer Screens \ V“ the CaChet defau,t
halftone setup.
)8 Use ‘Native’ Printer Screens \ L UK J P
1
Uncheck this box to include the Click here if you want to enter
halftone setup in the color PostScript code to customize the
separation file. dot shape.

If you leave the “Use Native Printer Screens” option checked,
Cachet does not include halftone setup information in the
color separation files. When you place the color separations in
a page layout application or generate films on an imagesetter,
the page layout application or imagesetter determines the
halftone setup. If “Use Native Printer Screens” is un-checked,
Cachet includes the halftone setup information in the color
separation files.

CAUTION:

Check with your service bureau before including halftone

setups in your color separation files. For the best results,

your service bureau may prefer that you not include
them. For more information on working with service

bureaus, refer to the EfiColor Profiles Guide.
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Printing Color Separations

TIFF-CMYK File Options If you are saving separations in TIFF-
CMYK format, the bottom half of the Save Separations dialog
box includes a Size button you can use to change the image
size and resolution before generating color separations. See the
description of the Size button above under “EPS/DCS File
Options.”

Raw File Options If you are saving separations in Raw-CMYK
or Raw-RGB format, the bottom half of the Save Separations
dialog box includes options for specifying the color format and
header size for the file.

— File Format Printer options

QOEPS Target Printer:| SWOP-Coated - |
O TIFF - CMYK
@® Raw - CMYK GCR Level:[ _High  ~]
O Raw - RGB
sharpening: None __~

— Raw File Dptions

Color Format
ivteteaiad Width: 517 Header Size: [0 |
Planar /“‘“QM: 344 /

((cancel/ ) [ ok ]|
7

/ I /
Click the Color Format ~ Cachet displays the Specify the header
you want. width and height in size (usually 0).

pixels here.



Using Cachet

Printing Color Separations

You can save the color separation data in interleaved format
(with the color components of each pixel listed together) or
planar format (with the first color component for all pixels
appearing first, followed by the second, and so forth). Use the
format that is appropriate for the next device that will be used
to read this file.
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Color separation files-
What format to use?

You use the Save Separations
command on the File menu to create
color separations of an image you've
corrected in Cachet. Cachet creates
color separation files that you can
include in a page layout application,
open with another image editing
application, or transfer to a non-
Macintosh computer system for further
work.

You can create color separation files in
five different formats:

TIFF-CMYK Supported by current
versions of most page layout
applications. Creates a single color
separation file containing image data
for all four CMYK layers.

Printing

EPS Supported by most page layout
applications. You can create EPS files
in binary or ASCII format. Files in ASCII
format are substantially larger than
those in binary format, so you generally
select ASCI| format only if your
application requires it.

DCS A variant of EPS originally
developed by Quark for use with Quark
XPress. Creates five separate color
separation files—one for each CMYK
layer, and one main control file.

Raw-CMYK A primitive format for
storing color-separated images. Used
only for exchanging separated images
with computer systems that cannot
interpret TIFF-CMYK, EPS, or DCS data.

Color Separations

Raw-RGB A special-purpose file format.
Used only for creating color separation
files you plan to print on 3-component
non-PostScript devices such as the
Kodak XL7700.

If you're planning to use your separated
images in a page layout application or
edit them using another Macintosh
image editing application, you'll usually
want to choose TIFF-CMYK, EPS, or
DCS. The table below shows which
formats you can use with a range of
common applications.
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Choosing Between TIFF-CMYK and

Application Ver. # TIFF-CMYK EPS DCS
DCcs

Adobe Photoshop 2.0,2.01 P S
If you're using the latest version of Adobe Phictaeh bet P =5
Quark XPress or PageMaker, you'll AUONE FIGISION. UL — =
have to choose between two preferred Aldus PageMaker 4.2 P St il
formats: jl'iFlf-CMYK and DCS. Here are Aldus PageMaker 401 St P
some guidelines to help you choose:

Aldus PageMaker 4.0 St
= Cachet create a single file for each
separated image in TIFF-CMYK format. Aldus PageMaker B St e
On the other hand, there are five Aldus Preprint 15 P S P
separate files for e:‘ach image you Aldus Preprint 10 st
separate and save in DCS format.

Letraset ColorStudio 15 P e o . P igA
* TIFF-CMYK format generally takes Quiark P ir p W S P
less disk space than DCS format. sbabalaliliis :

: Quark XPress 3.0 S

* Cachet can creates a screen preview
for each separated image in DCS Quark XPress before 3.0 P
format. Page layout applications can P = Preferred TSupported with Aldus Preprint 1.5 or later
use the screen preview to display the S= Supported tSupported with EPS Data Format set to ASCII text.

image.

* TIFF-CMYK files do not include a
screen preview. Instead, page layout
applications convert the CMYK values
in the file to RGB values for display. As
a result, moderate to gross color shifts
may occur when you place TIFF-CMYK
files into some applications. The
images, however, will print correctly.
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Using Cachet Reference

This chapter is your Cachet reference. The first section provides some basic
reference information about Cachet. It describes the Cachet software, reference
images, and file formats, explains plug-in modules, describes Cachet’s printing
support, and defines the system requirements for Cachet.

A menu-by-menu command reference provides a quick overview of what each
command does and how it works. At the end of the chapter, you'll find a table
of keyboard shortcuts that lists operations you can perform using the Shift,
Option, and Command keys.

Throughout this chapter, youll find cross-references to help you find more

information in earlier chapters. These references appear with an arrow in front

of them, like this:
=> “Exposure” in Chapter 2.

This means you should refer to the section called “Exposure” in Chapter 2 to
[find more information.
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Reference The Software:

Here’s what you need to

know about disks, files,

This section provides some and system requirements
basic reference information

about Cachet, including:

System Requirements The basic requirements your Macintosh
system must meet before you can use Cachet.

The Cachet Software The Cachet application, EfiColor
Processor, EfiColor database, reference images, supporting
files, and Cachet Installer.

Plug-in Modules Mini-programs that extend Cachet’s capabilities.

Files and File Formats Four kinds of files you use with Cachet:
image files, color separation files, script files, and halftone
setup files.

Printing Support EfiColor device profiles ensure faithful color
reproduction of your image with a wide variety of printers and
printing processes.
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System Requirements

Reference The Software

To use Cachet, your Macintosh system must meet the following
requirements: '

CPU: Macintosh II family with math co-processor

Memory: At least 5 MB RAM (8 MB or more recommended)
Video card: 8-bit or 24-bit color video

Monitor: Color monitor, 13 inches or larger

Storage: 2-4 megabytes hard disk space for a minimum
installation or approximately 20 MB for a complete
installation, depending on the number and size of images
youre working with

System software: System 6.0.5 or later with 32-bit QuickDraw,
or System 7

Using 8-bit video If you use 8-bit color video, performance will
be reduced. In particular you cannot get immediate updating
of the image as you work with tools in the Exposure & Tone

palette, and the quality of colors displayed is lower overall.

Compatibility with certain 24-bit video cards Some 24-bit video
cards may not be able to update colors immediately as you work
with the Exposure & Tone palette. Such video cards may cause
system errors unless you uncheck the “Immediate feedback with
millions of colors” option in the Performance section of the
Preferences dialog box.
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The Cachet Software

Reference The Software

The Cachet software includes the Cachet application, the
EfiColor database and EfiColor processor, a collection of
reference images, a set of images to use with the tutorial in
Learning Cachet, supporting files, and an Installer you can use
to install what you need automatically. This section gives the
derails.

The Cachet Installer

The Installer automatically installs the Cachet application and
supporting files on your hard disk. Refer to the Start Here
guide for instructions on using the Installer. After you install
Cachet, your Cachet folder should look something like this:

E Cachet =———=———p=  [his folder
7 items 1235 MB in disk g ME available conrallns the
E\g EfiColor database.
EfiColor DB PicturePress 20.1 Photoshop | | THiS plug-in module
is included with
Reference Im mrmm%}m'a\_“ Cachet.
I~ . -
This folder contains
compressed
reference images.
i
I \\ [Z&|  This folder contains
This is the Cachet This folder contains unfcompre.s.'sed
application. images you use with fEGEBeO nages
the tutorial in Learning
Cachet.

The Installer also places a file called EfiColor Processor in your
system folder, and two files in the Preferences folder in your
system folder: Cachet Preferences and EfiColor Preferences.
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Cachet

EfiColor DB

Reference The Software

The Cachet application

The Cachet application runs under Macintosh Operating
System 6.05 or later. To check the version number and serial
number of your Cachet software, choose About Cachet from
the Apple menu.

The EfiColor database
This folder contains the EfiColor database. This database

includes a series of device profiles that Cachet relies on
whenever you use the gamut alarm or the color meter, print
an image on a color printer, or create color separation files.

You can choose not to install all the device profiles, but you
will need a device profile for each printer or printing process
you plan to use.

=> “Printing Support” later in this section.



Usf?lg Cachet !(’a.j_ﬂ'r(’f.’t'a' The S{gﬁrwm'

D Reference images

Reference Images/JPEG

Cachet comes with a set of reference images. These images
have a gamma of 2.2 and were printed using color separations
created in Cachet. You use these images as guides when you

makc CO}O]‘ co ['I'CCinI"IS.

The Cachet Reference Image Guide shows how the reference
images look when printed. The images represent a variety of
lighting conditions and subjects.

=> “Reference Images” in Chapter 1.

Cachet

m Tutorial images

: Cachert also comes with a set of images that go with the
Tutorial g 8

tutorial in Learning Cachet. You can choose not to install the
tutorial images, but you'll need to install them if you want to
use the Learning Cachet guide. You can delete them later when
you're finished with the tutorial. See Learning Cachet for

details.

Cachet
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Plug-in Modules

Reference The Software

Plug-in modules are mini-programs developed by third-party
vendors. These mini-programs work with Cachet to provide
features that Cachet does not provide by itself. Plug-in modules
are generally distributed on floppy disks and come with their
own separate documentation. With Cachet, you can use plug-
in modules compatible with Adobe Photoshop.

Cachet supports two kinds of plug-in modules:

¢ Import plug-ins let you control a scanner or video frame
grabber, de-compress a compressed image file, or open a file in
a format Cachert does not normally support (such as Photo CD).

* Export plug-ins let you save Cachet image data in a file
format that Cachet does not support by itself, or control
printers (like the Kodak X1.7700) that are not available
through the Macintosh Chooser.

Some plug-in packages provide both import and export
functions. For example, you can use plug-in modules to save
disk space by compressing and de-compressing image files.

To use plug-in modules, you must install them on your
Macintosh. If you install plug-in modules in the same folder as
the Cachet application, Cachet will find them automatically. If
you install plug-ins in a different location, you need to set the
“Program Extensions Folder” option in the Folders section of
the Preferences dialog box.

Cachet lists your plug-in modules in a pop-up menu in the
dialog boxes you see when you choose Import or Export from
the File menu. When you use a plug-in module, it displays its
own dialog box with settings and options appropriate for the
operations it performs.
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Files and File Formats

Reference The Software

You work with four types of files in Cachet:
* Image files that you color correct or use as reference images.

* Color separation files that you create with the Save
Separations command on the File menu.

* Script files that you create with the Save Script command on
the Playback menu.

* Halftone setup files that you create with the dialog box that
appears when you click the Halftone button in the Print or
Save Separations dialog box.

Image Files

Image files contain digital images. That is, they contain the
dara that describes an image that has been scanned or captured
from a video source. Cachet can open and save image files in
four formats:

* TIFF-RGB

* PICT

* Adobe Photoshop
* Raw-RGB

Cachet cannot open files in either TIFF-CMYK or
Raw-CMYK format.
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House TIFF-RGB

House PICT

House Photoshop

Reference The Sofiware

TIFF-RGB files Tag Image File Format (TIFF) is a standard
graphic file format used on a variety of computers, including
Macintosh, MS-DOS, and Unix systems. There are TIFF
variants for RGB and CMYK data, called TIFF-RGB and
TIFF-CMYK respectively. Cachet can save color separations

in TIFF-CMYK format and can open and save image files in
TIFF-RGB format.

=> “To open a file in TIFF-RGB, PICT, or Photoshop format as
the working image” in the section on “The Working Image” in
Chapter 1.

PICT files PICT is a standard graphic file format for the
Macintosh and is also supported by some IBM PC applications,
including Corel Draw. PICT files may be compressed when
you save them and de-compressed when you open them.

=> “To open a file in TIFF-RGB, PICT, or Photoshop format as

the working image” in the section on “The Working Image” in
Chapter 1.

Adobe Photoshop files These are image files saved in Adobe
Photoshop in its standard file format. Cachet can open and
save image files in this format.

=> “To open a file in TIFF-RGB, PICT; or Photoshop format as
the working image” in the section on “The Working Image” in
Chapter 1.
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House Raw-RGE

Reference The Software

Raw-RGB files Raw-RGB is a simple file formar for storing
digital images. It is most often used to exchange data between
very different applications or platforms. For example, you
might use it to open images produced by microphotography
with a scientific workstation.

Raw-RGB files consist of a header, which may be empty,
followed by image data. The image data may be either
interleaved, with the red, green, and blue values for each pixel
listed together, or planar, with all the red values first, followed

by all the green values, and then all the blue values.

You can open and save files in Raw-RGB format in Cachet.
However, to open it, you must know the size of the header
(usually zero), as well as the width and height of the image
in pixels. If you save an image in Raw-RGB format, Cachet
displays the header size, height, and width in a dialog box
before saving the file. You should make a note of this
information, since you'll need it if you want to open the

file in Cachet.

=> 10 open a file in Raw-RGB format as the working image” in
the section on “The Working Image” in Chapter 1.
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Color Separation Files

Color separation files are files you can use to produce color
composite proofs on a color printer or color separation films
on an imagesetter. Generally, you import color separation files
into another application—such as a page layout application—
before printing or producing films.

Color separation files include data for each layer of the color-
separated image—four layers for CMYK printing processes,
three for CMY and RGB processes. Color separation files
generally also include a screen preview that page layout
applications use to display the image.

=> “To create color separations” in Chapter 5.

You can create color separation files with Cachet in any of five
file formats:

¢ TIFF-CMYK

* Encapsulated PostScript (EPS)

* Desktop Color Separation (DCS)
* Raw-RGB

* Raw-CMYK
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House TIFF-CHMYK

House EPS

House DCS

Reference The Software

TIFF-CMYK files For color separations in TIFF-CMYK format,
Cacher generates a single file. This file contains the image data
for all four CMYK layers. Separations in TIFF-CMYK format
use less disk space than those in other formats, and a single
TIFF-CMYXK file is easier to keep track of than five DCS files.
However, TIFF-CMYK files may not look as good on the screen
once you place them in your page layout application. Although
TIFF-CMYK files do not contain a screen preview, many page
layout applications can generate one based on the TIFF-CMYK
dara. However, moderate to gross color shifts usually occur
with the screen previews generated by page layout applications.
Despite any color shifts you see on the screen, the images will
print correctly.

Encapsulated PostScript (EPS) files Encapsulated PostScript
(EPS) format is a standard graphic format used on a variety of
computers, including Macintosh, MS-DOS, and Unix systems.

Desktop Color Separation (DCS) files A variant of EPS, Desktop
Color Separation (DCS) format is the only way to use color-
separated images in versions of Quark XPress before 3.0. For
color separations in DCS format, Cachet generates five files:
one for each CMYK layer and one main control file. Many
other applications, including all versions of Quark XPress since
3.0, can also import DCS files. Separations in DCS format use
more disk space than those in other formats, and there’s more
work involved in keeping track of the five separate DCS files.
However, the screen previews included in DCS files look better

on the screen than the ones generated by page layout
applications based on TIFF-CMYK files.
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House Raw-CMYK .sep
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Reference The Software

Raw-RGB files Some printers can only accept color separation
files in Raw-RGB format, including the Kodak XL7700 and
the Hewlett Packard PaintWriter XL.

Raw-CMYK files Raw-CMYK is a primitive format for
exchanging color-separated images with systems that cannot
interpret any other format.

Script files

Script files are files that Cachet creates when you choose the
Save Script command from the Playback menu. They record
all the operations you've performed since you last saved the
image (or since you opened the image if you haven't yet saved
it). You can use the script later to perform the same operations
on a different image.

Script files appear on your disk as permanent files. However,
you cannot open them directly. When you choose the Apply
Script command from the Playback menu, Cachet reads the
script file you select and applies the changes to the current
working image.

> “Scripts” in Chapter 4.
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House Halft;ne Settings

Reference The Software

Halftone setup files

It takes time to specify the halftone setup—line frequency,
screen angles, and dot shape—you want for a particular printer
or printing process. Once you create a halftone setup, you can
save it in a file and re-use it later.

Halftone setup files are created when you click the Save button
in the dialog box that appears when you press the Halftone
button in the Print or Save Separations dialog box. You can
load a halftone setup you've previously created by clicking the
Load button in the same dialog box.
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Printing Support

Reference The Software

The EfiColor database consists of a series of device profiles
that Cacher uses to control color reproduction for a variety of
printers and printing processes. Each device profile describes a
single color printer or printing process. For example, there’s a
device profile for the QMS ColorScript 100, and there’s another
one for the combination of a 3M Matchprint proofing system,
a sheetfed press, and uncoated stock.

Cachet uses the information in a device profile to convert

the RGB values in an image file to CMYK (or other) values
appropriate for the printing process you are using. Cachet also
uses this information for identifying out-of-gamut colors with
the gamut alarm and for measuring CMYK values with the

color meter.

The EfiColor database that comes with Cachet includes a
basic set of device profiles. For more information, refer to the

EfiColor Profiles Guide.
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Manage files, print, and

create color separations

You use the File menu to do

the following:

* Open, close, save, resize and resample image files

* Cancel changes you've made and revert to the last saved
version of the working image

* Access plug-in modules
® Print on a color printer
* Create color separation files

Here are the details about each command on the File menu.

Open... Opens an image file you want to correct or use as a reference
image. You can open files in TIFF-RGB, PICT, Photoshop, or
Raw-RGB format. You cannot open EPS, TIFF-CMYK, or
Raw-CMYK files in Cachet.

The Open dialog box appears automatically each time you start
Cachet unless you uncheck the “Ask for a file when Cachet starts”
option in the Main section of the Preferences dialog box.

When you choose Open, Cachet displays a dialog box listing
files in TIFF-RGB, PICT and Adobe Photoshop format. The
dialog box also lists any TIFF-CMYK files, but you cannot
open these in Cachet.
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When you select a file from the dialog box, Cachet displays the
file format, the size of the file in bytes, the date the file was
created, and the date it was last changed. You can use other
options to see additional files and specify whether you want
to open the image as a working image or a reference image.

Select a file to open:

3 User Images ¥

D Puddle Stomping
0O Sunny Picnic
0O Vegetable Basket

o Hard Disk 2
0O New UP
0O On a Picnic
O On the Dock Desktop

L~ Click here to
open a file as the
working image.

Format: TIFF
File Size: 533,754 —Click here to
Created: 3/10/91, 11:24 AM .

open a file as a

Modified: 3/10/91, 11:24 AM See all files :
reference image.

Click here to open a Raw-RGB file.

For Correction This option opens the file as the working image.
You can open only one working image at a time. When you
open an image for correction, Cachet automatically displays
the Exposure & Tone palette.

= “To open a file in TIFF-RGB, PICT, or Photoshop format as
the working image” in the section on “The Working Image” in

Chapter 1.
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For Reference This option opens the file as a reference image.
Reference images are labeled “Reference” in the window’s title
bar. You can open several reference images at the same time.

»

= “To open a reference image” in the section on “Reférence Images
in Chapter 1.

See all files If you check this option, the dialog box lists all the
files in the current folder and activates the Format pop-up menu.
If you select a file that is not in TIFF-RGB, Adobe Photoshop
or PICT format, Cachet assumes it is in Raw-RGB format and
asks you for additional information when you click Open:

You must enter
Raw File Reading Options / the width and
Color Format width: THEE height in pixels.
!7@ Interleaved —‘ Height:|0 L~ Enter the header
Oy‘énﬂr Header Size:[o N size (usually 0).

3
Click the correct format for the file you selected.

When you click Open, Cachet tries to open the file. If the
file is not actually in Raw-RGB format, Cachet displays an

€Irror message.

> “To open a file in Raw-RGB format as the working image” in
the section on “The Working Image” in Chapter 1.
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Close Closes the active window and removes it from the Windows
menu. Clicking the window’s close box has the same effect as
choosing Close from the File menu.

If the active window contains a working image that you have
changed, Cachet asks you if you want to save your changes
before closing the window.

Save Saves any changes you have made to the working image,
replacing the original image file. Cachert saves the file in its
original format. Any snapshots you have taken are discarded.

=> “To save changes” in the section on “Files” in Chapter 4.

Save As... Saves the working image in a new image file whose name and
format you specify.

When you choose Save As, Cachet displays a dialog box that
you use to name your file and select the folder and drive where
you want to save it. A pop-up menu in the dialog box gives
you a choice of four formats: TIFF-RGB, PICT, Photoshop,
and Raw-RGB.

=> “To save the working image with a different name” in the
section on “Files” in Chapter 4.
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When you save an image in Raw format, Cachet prompts you
for additional information:

|/ You generally

Raw File Writing Options / don't need to
Color Format o Header Size: change this.
@ Interleaved Width: 344 _{— Cachet automa-
O Planar Height: 517 tically provides

these values.

[ cancel | |! 0K !l Make a note of
them if you want
to open this file
again in Cachet.

Click the format you want to save the file in.
Save Separations... Creates color separation files whose name and format you specify.

When you choose Save Separations, Cachet displays a dialog
box that you use to specify how you want the separations to

be created:
Choose the format for the color Choose the printer or printing process
separation files. you plan to use.
\ A
File Format Printer options \\ A | — Specffy the GCR
EPS Target Printer:[ SIWOP-Coated 1] Toal
O TIFF - CMYK ) evel.
O Raw - CMYK G6CR Level:[_High ¥ - ;
O Raw - RGB — Specify t{he
Sharpening: Sharpening level.
— Encapsulated PostScript File Options LA Click to change the
— File Format — Preview Picture —
ploki i S s halftone setup.
@ DCS (5 files) () Black and White 1~ Click to change the
@® 256 Colors s ofthe
— Data Format — DCS Image Data —, separated image.
O ASCII tent (O Only in sub-files
® Binary @ Also in main file
[ cancel J[[ ok ]|
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Target Printer This pop-up menu lists the device profiles
installed in your EfiColor database. You must choose the
printer or printing process you plan to use. This ensures that
the color separations will render the true colors of your image
on the printer or printing method you select.

=> “To create color separations” in the section on “Color
Separations” in Chapter 5.

GCR Level Choose the level of gray-component replacement
(GCR) that you want Cachet to perform on your image when
creating the color separation files. You can choose None, Low,
Medium, High, or Maximum. If the Target Printer does not
support different GCR levels, the GCR pop-up menu is set to
Nominal and cannot be changed.

=> “Gray component replacement (GCR)” on page 5-14.
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File Format You can create color separation files in five
different formats: TIFF-CMYK, EPS, DCS, Raw-CMYK, and
Raw-RGB.

=> “Files and File Formats” earlier in this chapter.
=> “Color separation files—Which format to use’ on page 5-28.

If you choose EPS, Raw-RGB, or Raw-CMYK, Cachet
displays a dialog box that you use to specify additional options:

— File Format Printer options
@ EPS Target Printer:| SWOP-Coated - |
O TIFF - CMYK
O Raw - CMYK GCR lauel:
Click Normal for\ || |©
a single EPS file, N .
DCS for five Rincapsulated PostScript File Options
— File Format —, — Preview Picture —
separate DCS O Normal O None
o ®) DCS (5 files) () Black and White
files. | @ 256 Colors
Choose Bina
ca | — Data Format —-/ — DCS Image Data —
unless your N O RscIl tent O Only in sub-files
page layout ® Binary Qﬂlsn in main file
application P AN
requires ASCII / \ (cancel J [ ok )
text.
7 N\
Choose the type of screen preview  Click here if you want to use the
you want. same DCS files to produce color
composite proofs and final,
separated films.

=> “To create color separations” in the section on “Color
Separations” in Chapter 5.
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Sharpening Choose the level of sharpening you want Cachet
to perform when creating the color separation files. You can
choose None, Low, Medium, High, or Maximum.

=> “Sharpening your image at output time” on page 5-16.

Halftone This button lets you modify the line frequency,
screen angles, and dot shape when you generate color
separations for a printer or printing process that supports
halftoning. You can save the halftone setup in a file, and then
re-use it later.

Click here to load a
halftone setup you have Click here to save your

previously saved. halftone setup.
b 3

Halftone Screens for swop_coated

L T
Frequency: [ 150.92] [ 150.92] [ 150.92] [ 150.92| Lines/ifh

fngle: | 82.50| | 5250/ |  7.50| | 112.50| Degrees

Dot Shape
r@ Round O Elliptical /Dl:ustum...

[J use ‘Native’ Printer Sl:reens/
)E Use ‘Native' Printer Scraeny / " UK y
7 7 7
Uncheck this box to Click here if you want  Click here to use
change line to enter PostScript Cachet's default
frequency, screen code to customize the  halftone setup.

angles, and dot shape.  dot shape.
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Size This button lets you change the size or resolution of the
separated image without changing the contents of the image

file itself. When you click the Size button, Cachet displays a

dialog box that you use to specify additional options:

L~ Enter the height,
Image size... idth luti
Current:  New: Unit: width, or resolution.
Width:  2.68 e Cachet calculates
whichever values
Height: 1.79 1.79 ,
you don't enter.
Resolution:  300.00  [300.00 |{pineis/inch ~} |
Choose the
File Size (Kb): 1,266 1,266 805 u 537 :
measurement unit
[ Preserve File Size from the pop-up
menu.

Cachet preserves the width-to-height or aspect ratio of the
image by automatically calculating whichever value you don'’t
enter. Cachet also adjusts the resolution to match the new
dimensions.
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Revert

Get Info...

Reference The File Menu

Restores the working image to the last version you saved.

Revert discards any changes you have made to an image since
the last time you saved it. To prevent accidental loss of data,
Cachet asks you to confirm this command before removing
your changes.

= “To revert to a previous version” in the “Oops” section in

Chapter 4.

CAUTION

You cannot undo the Revert command with the Undo

command.

Displays information about the image in the active window.
Get Info shows the name and location of the file, its size in
bytes, its dimensions in pixels, and its file format.

> “To get information about an image” in the section on “The
View Through the Window” in Chapter 1.
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Lets you resize or resample the working image.

When you choose Resize Image, Cachet displays a dialog box
that you use to specify additional options:

L~ Enter the height,
Image size... : :
Lurreat NEL Unit: width, or resolution.
Width:  2.68 T Cachet calculates
whichever values
Height: 1.79 1.79 don'tentor
you ;
Resolution: 300.00 300.00 -F pixels/inch :}- b
Choose the
File Size (Kb): 1,266 1,266 805 # 537 -
measurement unit
/a Preserve File Size from the pop-up
menu.

7
Uncheck this box to resample the image.

The minimum dimensions are 16 pixels by 16 pixels. The
maximum width is 4,095 pixels; there is no practical height
limit. You can convert these limitations to inches or
centimeters as long as you know the resolution of your printer.

On a 300 dpi device:

cove < 1B .
16 pixels: 300 =0.054 inches

o 4095 ’
4095 pixels: 200 =13.65inches

Cachet preserves the width-to-height or aspect ratio of the
image by automatically calculating whichever value you don’t
enter. Cachet also adjusts the resolution to match the new
dimensions.
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Import...

and Export...

Page Setup...

Print...

Reference The File Menu

Gives access to plug-in modules you've installed.

These commands appear dimmed unless you have installed at
least one plug-in module. When you choose Import or Export,
Cachet displays a dialog box so you can choose the plug-in
module you want. Then, the plug-in module displays its own
dialog box with options appropriate to its functions. (Most
plug-ins come with documentation that explains how to use
any options provided in this dialog box.)

=> “Plug-in Modules” earlier in this chapter.

=> “To open a compressed image as the working image” and “To
scan a slide or photograph or capture a frame from a video source”
in the section on “The View Through the Window” in Chapter 1.

=> “To save an image in compressed format” in the “Files” section

in Chapter 4.

Displays a dialog box with page setup options for the printer
you have selected with the Chooser. See your Macintosh user’s
guide and the documentation that comes with your printer for
information about using the Chooser and setting up your
printer.

> “To set up the printed page” in the section on “The Early
Proof” in Chapter 5.
Prints the working image on the printer you have selected with

the Chooser.

=> “To print directly from Cachet” in the section on “The Early
Proof” in Chapter 5.
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The Print command displays a dialog box with printing
options for the printer you have selected with the Chooser.
Regardless of which printer you are using, the Print dialog box
includes several options you use to specify how you want the
working image to be printed.

Chaose the format for the color Choose the printer or printing process
separation files. you plan to use.
File Format Printer options
EPS Target Printer:| SWOP-Coated I | Specify the GCR
O TIFF - CMYK
O Raw - CMYK GCR Level:| High _ ~ level.

O Raw - RGB

Sharpening: [~ Specify the

Sharpening level.

— Encapsulated PostScript File Options

File Format — — Preview Picture — e —~ Change the
‘ O Normal O None
@ DCS (5 files) O Black and White [I} halftone setup.
® 256 Colors Change the image
DataFormat—  — DCS Image Data —, size or resolution.
(O ASCII text O Only in sub-files
@ Binary @® RAlso in main file

([ cancel J [ ok ||

Target Printer This pop-up menu lists the device profiles
installed in your EfiColor database. You must choose a profile
for the printer you plan to use.

=> “To create color separations” in the section on “Color
Separations” in Chapter 5.
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GCR Level Choose the level of gray-component replacement
(GCR) that you want Cachet to use when creating the color
separation files. You can choose None, Low, Medium, High, or
Maximum. If the Target Printer does not support different
GCR levels or is not a CMYK device, the GCR pop-up menu
is set to Nominal and cannot be changed.

=> “Gray component replacement (GCR)” on page 5-14.
Sharpening Choose the level of sharpening you want Cachet to

perform when creating the color separation files. You can
choose None, Low, Medium, High, or Maximum.

> “Sharpening your image at output time” on page 5-28.
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Halftone This button lets you modify the line frequency, screen
angles, and dot shape when you generate color separations for
a printer or printing process that supports halftoning. You can
save the halftone setup in a file, and then re-use it later.

Halftone Screens for swop_coated / C"wk here to save
_ I/ your halftone setup.
s M: ¥: K: B
. |~
Frequency: [ 150.92] [ 150.92] [ 150.92] [ 150.92] Lines/inch (St ] ghf: here to load a
——L d... alftone setup you
fAngle: [ 82.50] | s2.50)|  7.50] [ 112.50] Degrees = ; PV
have previously
Dot Shape saved.
’T@ Round O Entiptical (? Custom... 1 S
Click here to use
[] use ‘Native’ Printer Screens \ |“ Ca':"her‘s def&u."t
- halftone setup.
ﬁllse ‘Native’ Printer Screens \ ! ,
\
Uncheck this box to change line Click here if you want to enter
frequency, screen angles, and dot PostScript code to customize the
shape. dot shape.

Size This button lets you change the size or resolution of the
printed image without changing the contents of the image file
itself. When you click the Size button, Cachet displays a dialog
box that you use to specify additional options:

L~ Enter the height,
Image size... " -
Gt Nede Unit: width. or resolution.
Width:  2.68 e Cat.ther calculates
) whichever values
Height:  1.79 1.79 =
you don't enter.
Resolution:  300.00 {SDD.BEI H pinels/inch =}
Choose the
File Size (Kb): 1,266 1,266 805 1 537 ;
measurement unit
[ Preserve File Size from the pop-up
menu.
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Quit...

Reference The File Menu

Cachet preserves the width-to-height or aspect ratio of the
image by automatically calculating whichever value you don’t
enter. Cachet also adjusts the resolution to match the new
dimensions.

You can use pop-up menus to change the units of measure for
the image height and width. The options are: inches,
centimeters, pixels, and points. You can display resolution in
pixels per inch or pixels per centimeter.

Quits the Cachet application and returns you to the Finder. If
a working image is open when you quit, Cachet asks if you
want to save any changes you've made.
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Undo

Reference Edit Menu:

Undo changes, select

preferences, and use

The Edit menu is a standard standard Macintosh
menu in all Macintosh editing commands

applications. It includes the
Cut, Copy, Paste, Clear, and Show Clipboard commands that
you use to move data from one place to another within a file
and between files. You can use these commands with any desk
accessories you open, but they are not appropriate for editing
images in Cacher.

However, the Undo and Preferences commands on the Edit
menu are useful when you work in Cachet.

Reverses the effect of your last action on the working image.
When you choose Undo, the Undo command is replaced by
the Redo command. This command restores the original
action you undid.

You can undo most operations that affect the appearance of

the working image. You cannot undo any commands on the

File menu, however. When you cannot undo the most recent
operation, the Undo command appears dimmed in the Edit

menu.
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Preferences...

Check if you :
— Edit Preference: —

want Cachet to™] |

f ® Main H
s{s,?Ia);the Dpin O Folders

_'la 0g Dox eac O Performance ¥
time you start
Cachet.

Reference

Edit Menu

Lets you specify your preferences for options and settings in

three categories: Main, Folders, and Performance. When you

click a category, its options appear to the right in the dialog
box. The options for each category are as follows:

“Main” preferences

This category of preferences includes the following general

working options:

Main Preferences:

—& Ask for a file when Cachet starts
Lock MultiChoice to image window

— 2oom Clicks
@ Keep click under mouse

O Center click in window
\

— Zoom Step
@ Additive (x1,

75

(O Doubling (#1, 2,44, HB.
1 X,
T
/ / [ cancet | [ ok ||
N

7
Check if you want Specifies how much Determines the
Cachet to update the image is enlarged  position of the image

the images in the
MuiltiChoice window
when you zoom or
scroll the working
image.

or reduced each time
you click the zoom-in
or zoom-out tool.

in the window after
you zoom.
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Zoom clicks You have two options for Zoom Clicks:

* “Keep click under mouse” tells Cachet to keep the point you
click in the same position in the window when the image is
reduced or enlarged.

* “Center click in window” tells Cachet to move the point you
select to the center of the window when the image is reduced
or enlarged.

Zoom steps You also have two options for Zoom Steps:

* “Additive” enlarges and reduces slowly—increasing the

multiplier by 1 with each step—1X, 2X, 3X, 4X, and so on.

* “Doubling” enlarges and reduces more quickly—doubling
the multiplier with each step—1X, 2X, 4X, 8X, and so on.

=> “The View Through the Window” in Chapter 1.
=> “Multiple Choice” in Chapter 2.
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Tells Cachet ——
— ference: —

where to store — Temporary Files Folder

O Main '"[~® System Folder
the temporary e e O custom... | |
files that are O Performance Program Ext Folder

— L

created as you | ® cachet Folder
work. Y] O custom... | |

Edit Menu

“Folders” Preferences

These preferences let you tell Cachet what folders you want to
use for temporary files, plug-in modules, and halftone setups.

— Halftone Files Folder
Cachet Folder
O Bystom... | |

i ((cancet | [ ok

# %

7 =
Tells Cachet where to look for

plug-in modules.

Tells Cachet where to store
halftone setup files you create.

Temporary files folder Cachet creates temporary files as you
work. By default, Cachet stores these temporary files in your
system folder. You can click Custom to specify a different
folder. If you don’t have enough space on your startup disk to
work with large images, you can specify a folder on another
disk that has more space.

Program extensions folder If you are using plug-in modules for
importing and exporting images, you must tell Cachet where
these programs are located. By default, Cachet assumes that
plug-in modules are stored in your Cachet folder. If not, you
can click Custom to specify another location. You'll need to
install all of your plug-in modules in the same folder.

=> “Plug-in Modules” earlier in this chapter.
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Halftone files folder If you create halftone setups that you want
to re-use, you have the option of saving them in files. By
default, Cacher saves halftone setups in your Cachet folder.
You can click Custom to specify a different folder.

=> “To create color separations” in the “Color Separations” section

in Chapter 5.

=> “To print directly from Cachet” in the section on “The Early
Proof” in Chapter 5.

“Performance” Preferences

These options help you tailor the performance of Cachet to
your needs:

Updates the ———

ik — reference: —
working image Performance Preferences:
O Main H

in real-time as ~&J Immediate feedback with millions of colors

K ) Folders
gu work with @ Performance Busy Cursor
posure & O No busy cursor
Tone palette, After [ 20 |[§] tenths of a second
provided you

1 2
are using 24-bit Use [50 ]3] % of memory for images
- (Takes Effect Next Time You Run Cachet)
color video. \
/ \ ((cancet ) [ ok |

> X

Tells Cachet how soon to display Improves the speed of image
the busy cursor—a rotating ball—  processing by increasing the
when processing an image. memory available for some

functions and reducing it for
others.
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Immediate feedback If you are using 24-bit color video,
Cachet normally updates your working image immediately as
you make adjustments with the Exposure & Tone palette. For
example, you see the effect of dragging the white point slider
to the left or right even before you release the mouse button.
Some 24-bit cards cannot update immediately, and you may
experience system crashes with such video cards. To solve the
problem, uncheck the “Immediate feedback with millions of
colors” option. This option has no effect if you are using an
8-bit color card.

Busy cursor By default, Cacher displays a busy cursor (the
rotating ball) if an operation takes longer than two seconds.
You can adjust this time delay if you want to be alerted sooner
(or later).

Memory allocation If you want to improve the performance for
image processing functions, you can increase the amount of
memory allocated to these functions. However, you may run
out of memory if you try to open several tools—such as the

MultiChoice window, the PANTONE window, and the color

meter—art the same time.



Using Cachet

Tools for Viewing Images

[

a

-J'L PI:I

Reference Image Menu:

Four palettes—adjust

colors, crop, and change

Cachet comes with four tool the orientation
palettes for working with color

images. Three of them have tools for adjusting one or more
color characteristics. Most of these tools are sliders that
represent a range of possible values for the given color
characteristic. A fourth palette has tools for cropping the image
or changing its orientation.

In addition to their individual tools, all palettes share a set of
viewing tools. These are:

Zoom-in

You use the zoom-in tool to magnify the image in a window.
When you select this tool and move the pointer into an image
window, the cursor becomes a magnifying glass with a plus
sign at its center. When you click the image, Cachet enlarges
it. You can control the amount of enlargement with the
“Zoom Steps” option in the Main section of the Preferences
dialog box. If you hold down the Option key while this tool is

selected, Cachet temporarily switches to the zoom-out tool.

Zoom-out

You use the zoom-out tool to reduce the image in a window
and view more of it. When you select this tool and move the
pointer into an image window, the cursor becomes a
magnifying glass with a minus sign at its center. When you
click the image, Cachet reduces it. As with the zoom-in tool,
you can control the amount of reduction with the “Zoom
Steps” option in the Main section of the Preferences dialog
box. If you hold down the Option key while this tool is

selected, Cachet temporarily switches to the zoom-in tool.
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W

Exposure & Tone...

Color filter
Color handles

Color
indicator

Sliders

Tone clipping
alarm

Reference Image Menu

Hand tool

You use the hand tool to move an image around in its window.
In comparison to the scroll bars, which move an image
horizontally or vertically, you can use the hand tool to move
the image in any direction.

Reset button

All the tool palettes except the Orientation palette include a
Reset button. This button resets all the tools on the palette to
zero (0). The zero setting represents the image as it appeared
when you opened the tool palette.

Displays a palette with tools for correcting exposure problems
and adjusting the overall tone of an image. The tools in the
Exposure & Tone palette are the color filter and sliders for
exposure, white point, black point, contrast, midtones,
highlights, and shadows. The changes you make with these
tools apply to the entire image. In addition, this palette has a
clipping alarm that you can use to check for clipping of tones

in highlights and shadows.

If you are using a 24-bit color video card, Cachet updates the
working image immediately as you make changes with tools in
this palette. For example, you see the effect of dragging the
white point slider to the left or right even before releasing the
mouse button.
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Exposure

The exposure tool compensates for exposure problems—that
is, improper shutter speed or f-stop—in the working image.
Underexposed images appear to be too dark. Overexposed
images appear to be too light.

When you increase the exposure setting, Cachet adjust the
image so it appears to have been taken at a lower f-stop or a
slower shutter speed. When you decrease the exposure setting,
Cachert adjusts the image so it appears to have been taken at a
higher f-stop or a faster shutter speed.

= “Exposure” in Chapter 2.

Color filter

The color filter corrects color balance problems by adjusting
the balance of red, green, and blue tones in an image. Color
balance problems typically occur when the film, lighting,
and/or camera filter don’t match.

The six color handles around the color wheel represent the
basic colors in two color spaces: red, green, and blue on one
hand; and cyan, magenta, and yellow, on the other. You can
click these color handles to shift the color balance
incrementally in the direction of one of the basic colors.

You can also change the color balance by dragging the donut-
shaped color indicator in the color filter. The colors in the
middle of the filter are neutral. Those around the edge are
more saturated. The color indicator is initially set to the
neutral position in the center of the wheel.

=> “Color Filter” in Chapter 2.
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White point and black points

Photographic images have a range of tones from dark to light.

* The white point is the point where the light tones in an
image become white. When you increase the white point
setting, more light tones are represented as white. When you
decrease the white point setting, fewer light tones are
represented as white.

® The black point is the point where dark tones in an image
become black. When you increase the black point setting,
more dark tones are represented as black. When you decrease
the black point setting, fewer dark tones are represented as

black.
=>  “White and Black Points” in Chapter 2.

Contrast

Contrast is the ratio between the brightness of the light and
dark areas in an image. The contrast tool changes this ratio.

When you increase the contrast, the difference between the
lightest and darkest areas becomes more pronounced. When
you decrease the contrast, this difference becomes less
pronounced.

= “Contrast” in Chapter 2.
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Midtones, Highlights, and Shadows

The midrones, highlights, and shadows tools adjust the
brightness of an image. Each tool affects a different part of the
range of tones in the image.

* The highlights tool affects principally the lighter end of the
range. Increasing the highlights setting makes the lighter tones
brighter; decreasing it makes them less bright.

* The midtones tool affects principally the tones in the middle
part of the range. Increasing the midtones setting makes the
mid-range tones brighter; decreasing it makes them less bright.

* The shadows tool affects principally the darker end of the
range. Increasing the shadows setting makes the darker tones
brighter; decreasing it makes them less bright.

The effects of these three tools overlap considerably. This
prevents harsh transitions that might create undesired effects in
images.

> “Midtones, Highlights, and Shadows” in Chapter 2.
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Color cast tool

Color
indicator

Reference Image Menu

Tone clipping alarm

The tone clipping buttons let you highlight clipped areas in
the working image—areas of pure white and pure black. If too
many tones in your image are clipped, you may be losing

details in the highlights and/or the shadows.

The Check button analyzes the image for clipped tones. The
Show button shows the result of the analysis. Areas of pure
white are highlighted in black. Areas of pure black are
highlighted in white.

= “Tone Clipping” in Chapter 2.

Displays the Color palette, which includes tools for adjusting
the color cast, saturation, and lightness of the working image.

You generally use the tools in the Color palette for enhancing
the colors in an image to create a particular mood or
ambiance. The changes you make with these tools affect the
entire image.

Unlike the Exposure & Tone palette, the Color palette does
not update the working image immediately as you make
changes. For example, you do not see the effect of dragging the
saturation slider to the left or right until you release the mouse
button.

Color cast

A color cast is an overall tint of an image. Changing the color
cast of an image can change the overall mood or ambiance of
the image.
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The color cast tool is a color map. The color cast of the
original image is represented by the center of the color map. It
changes as you move the color indicator from the center. You
can click anywhere in the map to shift the color cast.

= “Color Cast” in Chapter 2.

Saturation

Saturation is the purity of a color—for example, the difference
between a pale red and a deep, vivid red. The saturation tool
increases or decreases the overall saturation of the image.

When you increase the saturation setting, the colors appear
more pure. When you decrease the saturation, the colors
become more neutral, diluted with gray.

=> “Saturation” in Chapter 2.

Lightness

Lightness is a measure of how light or dark colors in an image
appear, regardless of their hue or saturation. For example,
lightness is the component that makes light blue different from
dark blue. The lightness tool changes the overall lightness of

the image.

When you increase the lightness setting, the image becomes
lighter. When you decrease it, the image becomes darker.

= “Lightness” in Chapter 2.
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Selective Color...

Wand
Dropper
Constraint
|| Start Bexd Se
Calor Cast tools

Reference Image Menu

Displays a palette with tools for adjusting specific colors in an
image. The Selective Color palette, like the Color palette, has
tools for adjusting color cast, saturation, and lightness. In
addition it has tools for selecting and matching colors and for
constraining color changes to particular areas of the image.

Constraint tools

The Selective Color palette includes three constraint tools: the
rectangular marquee, the elliptical marquee, and the lasso. You
use these tools alone or in combination to outline the regions
in an image where you want to apply selective color changes.
When you click colors with the wand, Cachet only selects
pixels within the outlined areas.

After using one of these tools to outline a region, you can add
to that region by holding down the Shift key while outlining
another region with the same or a different constraint tool.
The regions you outline do not have to be contiguous.

You can “de-outline” a region or part of a region that you have
already outlined. To do so, hold down the Command key
while outlining the region you want to “de-outline.”

=> “Masks” section in Chapter 3.

The rectangular marquee This tool outlines a rectangular area
of any dimension. The rectangle is normally anchored at the
point where you click and begin dragging with this tool. If you
hold down the Option key, though, the rectangle is anchored

at a center point and drawn outward.
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The elliptical marquee This tool outlines an elliptical or
circular area of any dimension. The ellipse or circle is normally
anchored at the point where you click and begin dragging with
this tool. If you hold down the Option key, though, the ellipse
is anchored at a center point and drawn outward.

The lasso This tool outlines an area that you draw frechand. If
the area you draw with the lasso is not enclosed, Cachet draws
a line from the point where you begin drawing to the point
where you release the mouse button.

Wand

The wand selects the colors you want to adjust. You click on a
color you want to adjust, and Cachet selects all pixels in a
range of colors close to the color of the pixel you click. You can
adjust this range (see “Range” below). If you have outlined one
or more areas with the constraint tools, Cachet only selects
pixels within the outlined areas.

After you select one range of colors, you can add to the
selection by holding down the Shift key while clicking another
pixel with the wand.

If you hold down the Option key while this tool is selected,
the wand temporarily becomes the dropper.

=> “To select colors” in the section on “The Tools” in Chapter 3.

Show button

The Show button highlights the pixels you've selected with the
wand. If no pixels are selected, the Show button is dimmed.

=> “To select colors” in the section on “The Tools” in Chapter 3.
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Range

This option specifies how wide a range of colors is selected
each time you click a pixel with the wand. A low range setting
selects only pixels that are very close to the color of the pixel
you click. A high range setting selects more pixels with more
color variation. You click the up and down arrows to increase
and decrease the range setting from 1 to 30. The default
setting is 10.

=> “To select colors” in the section on “The Tools” in Chapter 3.

Dropper

The dropper picks up a color from a reference image or
another part of the working image and applies it to the selected
pixels in the working image. Cachet preserves the color
variation in the selected pixels when it applies the new color so
that you get a comparable variation in the new color.

If you hold down the Option key while this tool is selected,

the dropper temporarily becomes the wand.

= “T0 match selected colors automatically” in the section on “The

Tools” in Chapter 3.

Start Next Selection button

This button applies the selective color changes to the working
image, de-selects all the pixels, and resets the color cast,
saturation, and lightness tools.

Until you click this button, you can experiment with differer ¢
color changes. That is, you can select different colors with the
wand, change the size or shape of any regions outlined with



Using Cachet

Orientation...

Orientation
tools

Cropping tool

Reference Image Menu

the constraint tools, and apply different color changes with the
dropper or the color tools. But once you've pressed the Start
Next Selection button, you cannot undo any of these changes.

Displays a palette of tools for rotating, flipping, and cropping
the working image.

Orientation tools

You can use these tools to flip the image from left to right and
top to bottom. You can also rotate an image 90 degrees to the
left or right or 180 degrees.

= “To flip or rotate an image” in the “Orientation” section in
Chapter 1.

Cropping tool

You can use the cropping tool to crop the image. When you
select the crop tool and move the pointer into the image, the
cursor becomes a frame. You can then click and drag to draw a
frame around the part of the image you want to keep. Click
again inside the frame to complete cropping the image.

Once you save an image you've cropped, you cannot restore
the deleted portion of the image. Cachet permanently removes

the image data from the image file.

=> “To crop an image” in the section on “Orientation” in

Chapter 1.
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MultiChoice...

Cachet displays
six variations of
the working
image that show
different
settings for the
tool you select.

Reference Tools Menu:

Tools that make color

correction easier and

The Tools menu includes more accurate

several commands that you can

use to make color correction
easier, including a multiple-choice window for quick visual
adjustments, as well as tools for checking for out-of-gamut
colors, measuring color values, and specifying PANTONE
Colors.

Opens a MultiChoice window that displays six variations of
your working image. You can display variations for each of the
tools in the Exposure & Tone palette and Color palette. If
neither of these palettes is open, the MultiChoice command
appears dimmed.

The pop-up menu in the lower-left corner of the MultiChoice
window lists the tools in whichever palette is opened. The
variations show different settings for the selected tool.

Exposure_—a [T

Choose a tool from Click and drag to Click and drag to
this menu. change the size of the  change the size of the
images in the MultiChoice window

MultiChaice window. itself.
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Each variation represents
one step toward one of
the six color handles.

Reference Tools Menu

Cachet varies the images differently depending on which tool
you select. If you choose Color Filter from the pop-up menu,
Cachet gives you six variations as shown here:

When you choose any of the slider tools from the pop-up
menu, the MultiChoice window displays three variations in
either direction from the current working image. For example:

o === = = Mullitholce

[~

The current
i working image is
& in the center.

Lower white
point settings.
The current
working image
is between
these two
images.
Higher white
point settings.
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Reference Tools Menu

You can make changes with the tools in the tool palette while
the MultiChoice window is open. For example, you can make
major adjustments with the MultiChoice tool, and then fine-
tune using the sliders on the palette. Or, you can see the
combined effect of two tools—adjust one in the tool palette,
choose the other from the pop-up menu in the MultiChoice
window.

You can vary both the size of the MultiChoice window and the
size of the images within the window. The MultiChoice
window has a standard Macintosh size box in the lower-right
corner. The first image also has its own size box in the lower-
right corner. Adjusting the size of the first image adjusts the
size of all the images in the MultiChoice window.

> “Multiple Choices” in Chapter 2 for more information about
using the MultiChoice window.

Step...

Determines the amount of variation in the MultiChoice
window from one image to the next. The incremental change
can be Small, Medium, or Large. You can choose one of these
increments from the Step submenu. The default is Medium.

=> “To adjust the degree of variation among images” in the section

on “Multiple Choices” in Chapter 2.
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MultiChoice
Step

%M
»

loyout ) p

Gamut Alarm
Color Meter

Row
Column

PANTONE® Colors

Gamut Alarm

Sensitiuilg;m@

Turn up the sensitivity to find more of

the calors outside the printer’s gamut

Reference Tools Menu

Layout...

Determines the layout of the six images in the MultiChoice
window. You can choose one of three layouts from the
submenu:

Grid Displays a 2-by-3 grid, with a clockwise progression
starting from the upper left. This is the default layout.

Row Displays all six images in a single row, with values
increasing from left to right.

Column Displays all six images in a column, with values
increasing from top to bottom.

= “To change the layout of MultiChoice images” in the section on
“Multiple Choice” in Chapter 2.

Highlights out-of-gamut colors in the working image.

When you choose Gamut Alarm, Cachet opens a window with
buttons for checking and showing out-of-gamut colors. Pop-
up menus let you specify the target printer and control the
overall sensitivity of the gamut alarm.

The Check button analyzes the image and briefly highlights
the parts of the image that are out of gamut. You can hold
down the Show button or the Shift key to see these areas again.
Each time you adjust the image, you'll need to click Check
again to re-analyze the image.
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Color Meter...

PANTONE® Colors...

Reference Tools Menu

You can adjust the sensitivity of the gamut alarm with the
Sensitivity setting. You use the up and down arrows to select a
setting between 1 and 10. Higher settings are more sensitive
and show more out-of-gamut colors.

> “Color Checks” in Chapter 5.

Displays a window with tools for measuring the value of
individual colors in three different color spaces—RGB, LAB
(CIELAB), and CMYK (for a specific printer or printing
method).

When you open the window, the color scope is automatically
selected. When you move the pointer into the image area, the
cursor becomes a scope. When you click, Cachet reads the
values of the color under the scope. It displays the color as a
swatch in the Color Meter window and shows its position of
on a color map. You can drag to see the color values for
different color areas across an image.

You can choose a different color space from the Mode pop-up
menu. If you are measuring CMYK values, you must also
choose a printer from the Printer pop-up menu.

= “To measure color values” in the section “Color Checks” in

Chapter 5.

Opens a window from which you can select PANTONE
Colors. You can use this window with the tools in the Selective
Color palette to specify PANTONE Colors in part of your
image. You can also use the PANTONE Colors window to

compare colors in your working image to standard
PANTONE Colors.
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Reference Tools Menu

[ET]T======== PANTONE® Simulated Color Pages E
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Use the search tool to find a Enter a color number here, and
particular color. then click the Find button.

The first time you open the PANTONE Colors window, it
briefly displays some copyright information and then displays
a page of PANTONE Colors. You can scroll to see different
pages. You can also type the color number for a PANTONE
Color and click the Find button to go directly to that color.
The Paper pop-up menu lets you specify coated or uncoated
stock.

You can also use the search tool (the eye) to compare colors in
your working image to PANTONE Colors. When the search
tool is selected, you can click a color in the working image.
Cachet then finds a range of PANTONE colors close to the
color you selected and displays them in the PANTONE

window, with the closest color outlined.

You can use the dropper in the Selective Color palette to pick
up a color from the PANTONE colors window and apply it to
pixels you've selected with the wand.

= “PANTONE Colors” in Chapter 3.
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Take Snapshot...

Reference P[ayback Menu:

Snapshots and scripts for

keeping track of color

Cacher has two ways to track changes you like

color changes as you work.

Snapshots are temporary
records of changes you make to an image. Scripts are more
permanent records of a sequence of changes that you can apply
again and again to similar images. The commands for working
with snapshots and scripts are in the Playback menu.

Records the current state of the working image and saves it
temporarily with a name you provide. This command also
displays a list of snapshots you have taken previously.

When you choose this command, Cachet asks you to name the
snapshot. If you don't type a name, Cacher automarically
assigns a number to the snapshot. When you click Snap, the
current version is saved temporarily.

Snapshots are temporary. When you save changes, Cachet
discards all the snapshots you've taken.

> “To take a snapshot” in the section on “Snapshots” in
Chapter 4.
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Restore Snapshot...

Reference Playback Menu

Displays a dialog box that you can use to select a snapshot to
replace the current working image. You also use this dialog box
to view snapshots, rename them, and delete them.

When you choose Restore Snapshot, a dialog box lists all the
snapshots you have saved. When you select a snapshot and
click the Restore button, Cachet adjusts the working image to
match the appearance of the snapshot you select.

You can use the Preview button to view a snapshot without
losing the current working image. When you preview, the
snapshot temporarily replaces the working image, and the
dialog box remains open so you can preview another snapshot.
If you choose Cancel, the working image is restored. If you
choose Restore, the snapshot replaces the working image and
the dialog box closes.

The Rename button prompts you for a new name for the
selected Snapshot.

The Delete button displays a dialog box that asks you to
confirm that you want to delete the selected snapshot. If you
click OK, the snapshot is removed from memory and no
longer appears in the list of snapshots.

> Snapshots” in Chapter 4.
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Save Script...

Apply Script...

Reference Playback Menu

Creates a permanent record of all the operations you have
performed on the working image since you last saved it. The
script is saved as a file, and you can use it to apply the same
operations to other images.

When you choose Save Script, Cachet asks you to name the
script. When you click the Save button, the script is saved in a
file with that name.

> “To create a script” in the “Scripts” section in Chapter 4.

Applies a script created with the Save Script command to the
current working image.

When you choose this command, Cachet lists the scripts you
have previously saved. When you select a script and click the
Apply button, Cachet performs the operations in that file on
the current working image. If the script includes changes made
with the Orientation palette or with the constraint tools in the
Selective Color palette, Cachet asks if you want to apply these
changes when you apply the script.

=> “To apply a script” in the section on “Scripts” in Chapter 4.
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Zoom In
and Zoom Qut

Zoom

Reference Windows Menu:

Manage your windows

and find the one you

The Windows menu lists want in a hurry

commands that you can use to

manage windows. Zoom
commands give you an alternative to the zoom tools when you
are busy at work with another tool. Detail commands change
the amount of detail you see in the window by telling Cachet
to use more data or less data from your image file. And the
Windows menu also lists all the open image windows for quick
access when the window you want is buried under several
others.

Zoom In enlarges the image in the active window. Zoom Out
reduces it. These commands have the same effect as the zoom-
in and zoom-out tools in the tool palettes.

You can choose Zoom In or Zoom Out repeatedly to change
the magnification. You can control how much the image is
enlarged or reduced each time you choose the command by
setting the Main preferences in the Preferences dialog box.

> “To zoom in or out” in the section on “The View Through the

Window” in Chapter 1.

Magnifies or reduces an image by the amount you specify. A
submenu lists a variety of possible magnifications and
reductions. You can also use the zoom-in and zoom-out tools
to achieve a wider range of magnification and reduction.

> “To zoom in or out” in the section “The View Through the
Window” in Chapter 1.
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Standard Detail

File Detail

Reference Windows Menu

Displays the working image using the default size of the
internal model. The standard internal model is a subsampled
version of the image file. When you choose Standard Detail,
Cacher uses the standard internal model to display the working
image.

=> “To get more or less detail” in the section on “The View
Through the Window” in Chapter 1.

Rebuilds the internal model using all data in the image file,
and then displays the working image using all this data. While
this command improves the resolution of the image on the
screen and gives you finer control over selective color
correction, it requires more disk space and reduces Cachet’s
speed in some operations. (If your image file is relatively small,
Cachet automatically uses all the image data, regardless of
whether you select Standard Detail or File Detail.)

=> “To get more or less detail” in the section on “The View
Through the Window” in Chapter 1.
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Zoom Detail

List of Windows

Reference Windows Menu

Rebuilds the internal model to provide the best resolution
possible at the current magnification. If you zoom in and then
choose Zoom Detail, Cachet creates a new internal model
using more of the data from the image file to provide greater
detail. If you zoom out and then choose Zoom Detail, Cachet
uses less data from the image file and therefore improves
performance.

If you zoom in or out after choosing Zoom Detail, the internal
model will still be optimized for the previous magnification
level. Therefore, to maintain optimum resolution, you may
want to choose Zoom Detail again after you zoom in or out.

=> “To get more or less detail” in the section on “The View
Through the Window” in Chapter 1.

In addition to the Windows commands, the Windows menu
lists the open windows by name, so you can quickly select the
one you want. Windows are listed in the order in which you
opened them. Cachet labels windows with reference images.

When you select a window from the Windows menu, it moves
to the front and becomes the active window.

> “To select a window” in the section on “The View Through the
Window” in Chapter 1.
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8-bit color A method of
representing colors using 8 bits
per pixel. If you use an 8-bit color
monitor and display card, you can
simultaneously display up to

256 colors.

24-bit color A method of
representing colors using 24 bits per
pixel. If you use a 24-bit color
monitor and display card and you
have 32-bit QuickDraw, you can
simultaneously display over 16
million colors.

additive color system A system
in which color is produced by

combining primary lights additively.

In an additive color system, the
primaries are red, green, and blue.
When added together in proper
amounts, these colors produce
white. For example, an RGB
video moniror is an additive color
system. See also RGB color space,
subtractive color.

black point The point along the
range of tones in an image after
which dark tones appear black.

black point tool A slider in the
Exposure & Tone palette that
increases or decreases the black
point of an image.

chrominance A measure of the
combined hue and saturation of a
color. Chrominance is a measure of
a color without reference to
luminance. See also luminance.

Glossary

CIE Abbreviation of Commission
Internationale de I'Eclairage
(International Committee for
Color). Many color standards were
recommended by this committee.

CIELAB color space A standard
color space recommended by the
CIE in which colors are specified by
a lightness coordinate (L*) and two
chrominance coordinates (a* for
green-red and b* for blue-yellow). In
the CIELAB color space, equal
distances represent color differences
of roughly equal visual magnitudes.
clipping  See tone clipping.
CMYK color space A standard
way of representing color for
reproduction in a subtractive system
such as a printing press. In this color
space, colors are represented as
combinations of four colorants:
Cyan, Magenta, Yellow, and blacK
(CMYK). See also subtractive color
system.

color balance The relationship of
red, green, and blue tones in an
image. An image is color balanced if
tones that appear gray or neutral in
the original scene appear gray or
neutral in the image.

color cast A tint that results from
shifting the overall chrominance
(hue and saturation) of every pixel
in an image.

color cast tool A tool you use to
change the color cast of an image.
This tool can be used to create a
special mood or feeling in an image.
The color cast tool is in the Color
and Selective Color palettes.

color filter A tool in the Exposure
& Tone palette that you use to
correct the color balance of an
image.

color indicator A donut-shaped
marker that you use to specify color
changes with the color filter and
color cast tools.

color handles The six small,
circular markers along the outside
of the color filter that indicate
primary colors. You can click a
color handle to shift the color
balance in that direction.

color meter A tool that you use to
measure the color values of a color
you select in an image. You can
measure values in RGB, CIELAB or
CMYK (for a specific output device
and GCR level). The color meter is
in the Tools menu.

Color palette A palette of tools
you use to adjust the overall color
appearance of an image. The Color
palette includes the color cast,
saturation, and lightness tools. The
Color palette is available from the

Image menu.

color scope
color meter that you use to select the

The crosshairs in the

COlOl' you want to measure.
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color separation The process of
separating a color image into the
primary color components for
printing—generally cyan, magenta,
yellow, and black. Also used to refer
to the four pieces of film that result
from the process of separating a
color image.

color space A model for
representing color in terms of
measurable values, such as the
amount of red, green, and blue in an
image. Cachet works with three
standard color spaces: RGB,
CIELAB, and CMYK.

constraint tools The rectangular
marquee, circular marquee, and
lasso. You use the constraint tools to
define a mask when using the
Selective Color palette.

contrast The ratio between the
light tones and the dark tones in an
image. Adjusting the contrast
compensates for the effects of
undesirable lighting—for example,
oo harsh or too diffused—in the
original image.

contrast tool A slider in the
Exposure & Tone palette that you
use to increase or decrease the
overall contrast in an image.

crop tool A tool in the
Orientation palette that you use
to redefine the borders of the
working image.

Glossary

cropping ruler A tool in the
Orientation palette that you use to
see the size of the region of an image
you have selected with the crop tool.

Desktop Color Separation (DCS)
files A group of five files that
make up a color separated image. A
variant of EPS, DCS separates cyan,
magenta, yellow, and black data into
four files, linked together by a
smaller, fifth file. DCS files are used
for outputting high-resolution
separations to imagesetters, often in
conjunction with a page layout
application like Quark XPress. See
also Encapsulated PostScript (EPS).

device profile A collection of
information stored in the EfiColor
database that describes a particular
device or combination of devices
used in the printing process. Cachet
uses the device profile to calculate
the appropriate values when
reproducing a color image.

dot shape The type of dot used in
the halftoning process. Cachet offers
pre-defined dot shapes, as well as
user-defined and custom dots. See
also halftoning.

dropper A tool in the Selective
Color palette that you use to pick up
a color and apply it to selected pixels
in the working image.

elliptical marquee A constraint
tool in the Selective Color palette.
You use the elliptical marquee to
constrain selective color changes to a
circular or elliprical region.

Encapsulated PostScript (EPS)
An industry-standard formar for
saving files containing PostScript
images and graphics. EPS files can
be read by many Macintosh,
MS-DOS, and Unix application
programs, including word
processing, graphics, and page
layout applications. EPS files
optionally include a screen preview
so you can see the graphic or image
on the screen when you import it
into another application. Cachet
also supports DCS, a file format
based on EPS but that pre-separates
files for imagesetters. See also
Desktop Color Separation

(DCS) files.

end points The white point and
black point together are called the

end points.

exposure A measure of the
amount of light that passes through
a camera lens and is recorded on
film. Exposure affects the overall
brightness of an image. In the
photographic process, exposure is
controlled by aperture (f-stop) and
shutter speed.
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Exposure & Tone palette

A palette of tools for correcting
problems that generally occur as a
result of improper exposure, lighting
conditions, films, and filters in the
original photography. This palette is
available from the Image menu.

exposure tool A slider in the
Exposure & Tone palette that you
can use to compensate for errors in
exposure in the original photograph.

flip tools A pair of icons in the
Orientation palette that you can use
to mirror an image (left to right or
top to bottom).

gamut A range of colors. A device
gamut is the range of colors that a
device, such as a printer, can
produce. An image gamut is the
range of colors in a particular image.
See also out-of-gamut colors.

gamut alarm A tool you can use
to check for colors that are out of
the gamut of the printer or printing
method you plan to use. The gamut
alarm is available from the Tools
menu. See also out-of-gamur colors.

G!os.m:y

gray component replacement
(GCR) A technique for removing
from the color separations some or
all of the cyan, magenta, and yellow
content that produces gray and
replacing them with an appropriate
amount of black.

gray scale A graduated sequence
of gray tones from white to black.

halftoning A method thar uses
dots of various sizes to represent an
original continuous tone image. The
pattern is determined by the line
frequency, screen angle, and dot
shape. See also line frequency, screen
angle, dot shape.

hand tool A tool in all the palettes
that you can use to scroll through an
image that is too big to fit in its
window.

highlights The light tones in an
image. In a printed halftone image,
highlights are produced with the
smallest printed dots.

highlights tool A slider in the
Exposure & Tone palette that you
can use to increase or decrease
brightness primarily in the
highlights of a working image.
hue The attribute of a color
that gives the color its name—for
example, purple, red, orange,

or grccn.

image file A file that contains
image data in any of several graphic
formats. Cachet image files may be
in one of the following formats:
TIFF, PICT, Adobe Photoshop, or
Raw.

imagesetter A high-resolution
device for generating graphic output
on film or photographic paper.

internal model A subsampled
version of the working image.
Whenever Standard Detail is
checked in the Windows menu, you
are actually working with the
internal model rather than with the
actual data stored in the image file.
However, if you choose File Detail
or Zoom Detail from the Windows
menu, Cacher does not use the
internal model.

JPEG Abbreviation for Joint
Photographic Experts Group. Also a
set of image compression standards
developed by this group. The
reference images supplied with

Cachet are in JPEG format.

lasso A constraint tool in the
Selective Color palette. You can
use this tool to draw a freeform
mask that constrains selective
color changes. See also Selective
Color palette.
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lightness The brightness of an
area judged relative to the brightness
of a similarly illuminated area that
appears to be white. A measure of
the human response to luminance.
See also luminance.

lightness tool A slider in the
Color palette that you can use to
increase or decrease the lightness
of an image. The lightness tool
is also available in the Selective
Color palette.

line frequency (Ipi) A measure
of the frequency of the halftone dot
pattern. High line frequencies (more
lines per inch) provide higher
resolution than low line frequencies.
Line frequency is sometimes referred
to as screen frequency or screen
ruling.

luminance An objective, physical
measure of the amount of light
reflected from a surface.

mask A method of constraining
selective color changes to a selected
region in an image. With Cachet,
you outline the areas you want to
change with the lasso, rectangular
marquee, and circular marquee on
the Selective Color palette.
Everything outside the selected area
is masked and will not be affected by
changes you make with the Selective
Color Palette.

Glossary

midtones The middle part

of the range of tones in an image
(the range between highlights
and shadows).

midtones tool A slider in the
Exposure & Tone palette that you
can use to adjust the brightness
of the working image, primarily
in the midrones.

MultiChoice window A window
that displays six variations of the
working image. The variations
correspond to the tool you select—
six variations for the color filter, for
example, or six variations for
saturation. When you click one of
the variations, the associated
correction is applied to the working
image. The MultiChoice window is
available from the Tools menu.

Orientation palette A palette of
tools for cropping an image or
changing its orientation, including
flipping and rotating. This palette is
available from the Image menu.

out-of-gamut colors Colors in an
image thart are not within the gamut
of the target printer, proofing
system, or other reproduction device.
See also gamur, gamut alarm.

PANTONE® color A color that
is specified in the PANTONE
MATCHING SYSTEM®. This
system provides a standard for
describing printed colors using
specific inks.

PANTONE® tool A tool you use
to apply a simulated PANTONE

color to a region of an image.

PICT format A standard
Macintosh graphic file format.

pixel Abbreviation of “picture
element.” The smallest element of
a digital image.
Raw format
for image files.

A simple file format

rectangular marquee A constraint
tool in the Selective Color palette.
You use the rectangular marquee to
constrain selective color changes to a
rectangular region. See also Selective
Color palette.

lightness The brightness of an
area judged relative to the brightness
of a similarly illuminated area that
appears to be white. A measure of
the human response to luminance.
See also luminance.
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reference image A digital image
that has been color corrected in
Cacher and printed with color
separations created by Cachet. You
use a reference image as a guide to
correcting the color in your working
image. You can display one or more
reference images next to your
working image as you work. You
can also match individual colors in
your working image to individual
colors in a reference image.
resampling Changing the
resolution of an image by adding or
removing pixels, with a
corresponding change in file size.
Resampling reduces the sharpness of
an image and permanently alters the
information it contains.

resizing Changing the dimensions
and resolution of an image without
adding or removing pixels. Resizing
maintains the original ratios of
height and width to dpi. Resizing
does not permanently alter the
contents of an image file.

resolution The measure of how
detailed and fine an image is.
Resolution is generally measured as
a number of pixels per unit length,
for example 72 dots per inch.

Glossary

RGB color space An additive
color system typically used to
represent color on video screens.

Tools in the
Orientation palette that you use to
rotate an image 90° to the right, 90°
to the left, and 180°. See also

Orientation palette.

rotation tools

saturation The purity of a color.
Saturation determines whether
colors in an image appear pure
(high saturation) or diluted with

gray (low saturation).

saturation tool A slider in the
Color palette that you can use to
increase or decrease the saturation of
colors in an image. The saturation
tool is also available in the Selecrive
Color palette.

screen  The parttern of dots used
for halftoning. See also halftoning.

screen angle The angle at which
the screen is placed for each color
separation film. Typically, different
angles are used for each color to
minimize interference patterns
(called m0iré) that result from

overlapping screens.

script A file recording the editing
changes you have applied to an

image. You can use this file to apply
the same changes to other images.

selective color correction

Changes that you make to selected
colors in an image or region of an
image. See also mask, Selective Color
palette.

Selective Color palette A palette
of tools that you use to make
selective color corrections. These
tools include the wand and dropper
for matching colors automatically;

* constraint tools to limit changes to

certain areas of an image; and the
color cast, saturation, and lightness
tools for adjusting selected colors
manually. This palette is available
from the Image menu.

separation  Short way of referring
to “color separation.” See color
separation.

shadows The dark tones in an
image. In a printed halftone image,
shadows are produced with the
largest printed dots.

shadows tool A slider in the
Exposure & Tone palette that you
can use to increase or decrease
brightness only in the shadows of an
image.

sharpening A process of image
enhancement that produces a
“crisper” looking image.
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slider A control provided by many
of the tools you use in Cachet.

snapshot A temporary record of
your working image. You can use
snapshots to record intermediate
versions that you like while you
continue to experiment with

additional changes. See also script.

subsampling Reducing the
number of pixels in an image by
resampling the image.

subtractive color system

A system where color is represented
by combining subtractive colorants
such as paint, inks, or dyes. Typical
primaries are cyan, magenta, ycilow,
and black. When combined, they
produce dark colors. For example, a
printing press is a subtractive color
system, See also CMYK color space,
additive color system.

TIFF A standard graphics file
format for representing gray-scale
and color images. TIFF files can be
exchanged among several
environments, including Macintosh,
MS-DOS, and Unix. TIFF is an
abbreviation of Tag Image File

Format.

Glossary

tone clipping The loss of detail in
the highlights and shadows of the
image. You can use the Check and
Show buttons in the Exposure &
Tone palette to check for tone
clipping.

wand A tool in the Selective Color
palette that you use to select colors
you want to change.

working image The image you
want to color correct. In Cachet,
you work with one working image
at a time.

white point The point along the
range of tones in an image after
which light tones appear white.

white point tool A slider in the
Exposure & Tone palette that you
can use to increase or decrease the
white point of an image.

zoom-in tool A tool that you can
use to magnify the view of an image
in a window. The zoom-in tool is
available in all the tool palettes and
is equivalent to the Zoom In

command in the Windows menu.

zoom-out tool A tool that you
can use to reduce the view of an
image in a window. The zoom-out
tool is available in all the tool
palettes and is equivalent to the

Zoom Out command.
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Adobe Photoshop files, 1.4, 6.10
Black point tool, 2.20-25, 6.42
Check button, See Tone clipping
Clipping alarm, See Tone clipping
Color balance, 2.18

Color cast tool, 2.36-39

Color Filter tool, 2.14-15, 2.18-19,
6.44-45

Color Formar for

Raw-RGB files, 1.5
Color handles, 2.19
Color indicator, 2.19
Color Meter, 5.3, 5.8-9

Color palette, 2.4, 2.7, 2.9, 4.20,
6.44-45

Color properties, 2.7
Color scope, 5.8

Color separation files, 5.28, 6.12-14

Color separations, 5.18, 5.20-29
Color space, 2.3

Color tools, 2.36-37
Complementary colors, 2.19
Constraint tools, 3.5, 3.10, 6.46-47

Contrast tool, 2.20-21, 2.26-27,
6.42

Crop tools, 1.15, 1.17, 6.49

DCS files, 5.28, 6.13

Device profiles, 5.11, 6.16
Dimensions of Raw-RGB files, 1.5
Disk space, 1.3

Index

Edit by Reference, 1.1

Edit: Preferences, 1.22-23, 2.13,
6.34-38

Edic: Undo, 6.33
Elliptical marquee, 3.10, 6.47

End points,
See also white point, black point

End points, 2.22
EPS files, 5.28, 6.13
EPS/DCS Files, 5.22-25

Exposure & Tone palette, 2.3,
2.5-2.6, 2.9, 4.20, 6.40-44

Exposure problems, 2.5, 2.14-15
Exposure tool, 2.14-17, 6.41
Eye tool, 3.13, 6.54-55

File Detail, 1.24-25, 6.60

File formats, 1.3, 5.28-29, 6.9-15
File: Close, 6.20

File: Export, 4.16-17, 6.28

File: Ger Info, 1.26, 6.26

File: Import, 1.6, 1.7

File: Open, 1.4, 1.5, 6.17-19
File: Page Setup, 6.28

File: Print, 6.28-32

File: Quit, 6.32

File: Resize Image, 6.27

File: Revert, 6.26

File: Save, 6.20,

File: Save As, 6.20,

File: Save Separations, 6.21-25

Files:
Included with Cachet, 6.5-7
Opening, 1.4-1.7
Reverting to a
previous version, 4.21

Saving, 4.14-15

Saving in compressed

format, 4.16-17

See also Color Separation Files
See also Image Files
Overview,4.13-4.17

Formats supported, 6.9-15
Adobe Photoshop,1.4
Compressed, 1.6, 1.14

Flip tools, 1.15-16, 6.49

Gamut, 2.4

Gamut alarm, 5.4-7, 6.53-54
Halftone setup, 5.15, 5.25
Halftone setup files, 6.15

Header size for Raw-RGB files, 1.5

Highlights tool, 2.20-21,
2.28-33, 6.43

Image files, 4.13-17, 6.9-11

Image: Color, 6.44-45

Image: Exposure & Tone, 6.40-44
Image: Orientation, 1.15-1.17, 6.49

Image: Selective Color, 3.1-10,
6.46-49

Interleaved color formar, 1.5
Internal model, 1.4, 1.24
Lasso, 3.10, 6.47

Lightness tool, 2.36-37,
2.42-43, 6.45
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Main Preferences, 2.13

Masks, See also constraint tools,

3.5,3.9-10

Midrones tool, 2.20-21, 2.28-33,
6.43

MultiChoice tool, 2.8-2.13, 6.50-53
Orientation palette, 1.15-1.17, 6.49

Out-of-gamut colors,
See also gamut alarm, 5.3-5.6

PANTONE® Colors, 3.11-13,
6.54-55

PICT files, 1.4, 6.10
Planar color format, 1.5

Playback: Apply Script,
4.11-12, 6.58

Playback: Restore Snapshot,
4.6, 6.57

Playback: Save Scrip, 4.10, 6.58
Playback: Take Snapshot, 4.4, 6.56

Plug-in modules, 1.3, 1.6-7,
4.16-17, 6.8

Preferences, See Edit: Preferences

Printing, 5.10, 5.12-15, 5.17,
6.28-32

Range, 3.5, 6.48
Raw-CMYK files, 5.26, 5.28, 6.13

Raw-RGB files, 1.5, 5.26,
5.28,6.11

Rectangular marquee, 3.10, 6.46
Reference images, 1.2, 1.10-14

Index

Resetting tools on palettes, 4.20,
Resolution, 5.14, 5.24, 6.27
Reverting, 4.21, 6.26

Rotate tools, 1.15-16, 6.49

Saturation tool, 2.36-37, 2.40-41,
6.45

Scanning, 1.3, 1.7-9, 6.28
Script files, 6.14

Scripts, 4.9-12, 6.58

Scrolling, 1.20,

Search tool, 3.13, 6.54-55
Selecting colors, 3.4

Selective color changes, 3.3, 3.8

Selective Color palette, 3.3-10, 4.2,
6.46-49

Shadows tool, 2.20-21,
2.28-33, 6.43

Sharpening, 5.15-16, 6.24, 6.30
Size of images, 5.14, 5.24, 6.27-28
Snapshots, 4.3-4.8, 6.56-57
Standard Detail, 1.24-25, 6.60
System requirements, 6.4

TIFE-CMYK Files, 1.4, 5.26, 5.28,
6.23

TIFF-RGB files, 1.4, 6.17-19
Tone clipping, 2.6, 2.34-35, 6.44
Tone properties, 2.5

Tone tools, 2.20-21

Tools: Color Meter, 6.54

Tools: Gamut Alarm, 6.53-54
Tools: Layout, 6.53

Tools: MultiChoice, 6.50-52

Tools: PANTONE Colors, 6.54-55
Tools: Step, 2.12, 6.52

Undoing changes, 4.18-4.21

Wand, 3.4, 6.47

White point tool, 2.20-25, 6.42
Windows, 1.19-20, 6.61

Windows: File Detail, 1.24-25, 6.60

Windows: Standard Derail, 1.24-25,
6.60

Windows: Zoom, 6.59

Windows: Zoom Detail, 1.24-25,
6.61

Windows: Zoom In, 1.21, 6.59
Windows: Zoom Out, 1.21, 6.59
Working image, 1.2, 1.3

Zoom Detail, 1.24-25, 6.61

Zoom Preferences,
See also Edit: Preferences,1.22-23

Zoom tools, 1.21, 6.39
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Production Notes

This book, Learning Cachet, and the Reference Image Guide
were produced disk-to-film, using Microsoft Word, Quark
Xpress, Adobe Photoshop, and EFI Cachet.

The color images were color corrected in Cachet, output

on the Agfa SelectSet 5000 and printed on a Heidelberg
Speedmaster 102S press, on a 28"x40" sheet of Patina matte
book paper, with a 150 Ipi screen using Cachet separations,
with the SWOP-Coated profile.
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